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About this information product

...............................................................................................................................................................................................................................................................

Purpose This preface provides an overview of this information product, which
is the Navis™ Optical Provisioning Manager - Network Provisioning
(PM - NP) System Administration Guide, Release 1.0

The purpose of this Administration Guide is to explain to users how
to administer the Navis™ Optical Provisioning Manager - Network
Provisioning (PM - NP) System, Release 1.0.

Reason for reissue Issue 1 of this Administration Guide is a new document that supports
the Navis™ Optical PM - NP System, Release 1.0.

Safety labels This document does not use safety labels.

Intended audience This document is written primarily for operations personnel who
administer the Navis™ Optical PM - NP System.

....................................................................................................................................................................................................................................
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How to use this
information product

This document contains:

• task information, which includes administration tasks (that is,
step-by-step instructions).

• conceptual information, which is specific data related to the
tasks.

Both types of information is presented within the chapters of this
Administration Guide.

Chapter descriptions

The following table describes the information presented in each
chapter of this Administration Guide.

Section Title Description

Preface About this information product Explains this
document’s
purpose, its
intended audience,
and how to use the
document.

Chapter 1 Chapter 1, “Administration
Overview”

Provides an
overview of the
administration
process.

Chapter 2 Chapter 2, “Platform
Administration”

Contains HP-UX
and Windows
configuration set
up, printer set up,
power on and
power down tasks.

Chapter 3 Chapter 3, “System
Administration”

Explains how to
start and stop the
system, set
preferences, restart
the database and
how to perform
other system
administration
tasks.

Administration Guide About this information product
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Section Title Description

Chapter 4 Chapter 4, “User
Administration”

Explains how to
assign user
privileges and
restrict access to
the system.

Chapter 5 Chapter 5, “Provisioning
Administration”

Contains tasks on
managing areas,
aggregates, and
scheduled entities.

Chapter 6 Chapter 6, “Reliability and
Service Recovery ”

Provides
instructions on how
to perform hot and
cold backups.

Chapter 7 Chapter 7, “Off-Line Tool
Concepts”

Contains tasks for
off-line tools.

Chapter 8 Chapter 8, “EMS Management
”

Describes how to
add new element
management
systems, perform a
database
synchronization,
and view LAN
status information.

Chapter 9 Chapter 9, “Trouble Clearing” Contains
troubleshooting
procedures.

Chapter 10 Chapter 10, “Patch and
Software Upgrade Tasks”

Will provide
specific instructions
on how to upgrade
the system.

Appendix A Appendix A, “Navis™ Optical
PM - NP Filesystems”

Contains a list of
file systems.

Appendix B Appendix B, “Navis™ Optical
PM - NP Configuration
Parameters”

Serves as a
placeholder for
general information
about system
configuration
parameters.

Administration Guide About this information product
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Section Title Description

Index Index Enables the user to
find information
quickly on specific
topics.

Conventions used This Administration Guide relies on the following typographical
conventions to distinguish between computer input and output.

• When describing the Navis™ Optical PM - NP software, fields in
windows and field entries are identified with this font.

• When describing the UNIX® environment, text and numbers that
the user inputs to the computer are identified with boldface
type.

• In the UNIX environment, text and numbers that the computer
outputs to the user are identified with monospace type.

Related documentation This Administration Guide is part of a set of documents that supports
the Navis™ Optical PM - NP System.

List of documents

The document set that supports the Navis™ Optical PM - NP System
comprises:

1. The Navis™ Optical Provisioning Manager - Network
Provisioning (PM - NP) System Getting Started Guide,
(365-314-104) instructs users how to begin using the product to
provision and manage a network. This document includes tasks
and conceptual information.

2. The Navis™ Optical Provisioning Manager - Network
Provisioning (PM - NP) System Provisioning Guide,
(365-314-100) instructs users how to use the product to provision
and manage a network. This document includes tasks and
conceptual information.

Administration Guide About this information product
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3. The Navis™ Optical Provisioning Manager - Network
Provisioning (PM - NP) System Maintenance Guide,
(365-314-101) instructs users on how to maintain the product and
the network. This document includes tasks and conceptual
information.

4. The Navis™ Optical Provisioning Manager - Network
Provisioning (PM - NP) System Administration Guide,
(365-309-102) instructs users on how to administer the product
and the network. This document includes tasks and conceptual
information.

Glossary

This Administration Guide contains a glossary that will be helpful to
users of the Navis™ Optical PM - NP System.

On-line documentation

On-line documentation for the Navis™ Optical PM - NP System is
provided in two formats:

1. An on-line version, in HTML format, of this document set is
provided as part of the Navis™ Optical PM - NP software.

2. An on-line version, in HTML format, of this document set is
available on CD-ROM. The CD-ROM, which is titled Navis™

Optical PM - NP User Documentation CD-ROM, (365-314-103),
includes the full set of documents listed previously.

Screen help

The Navis™ Optical PM - NP software includes screen help for each
form, which describes the purpose of the form, each field, and each
button.

How to comment To comment on this information product online, go to
http://www.lucent-info.com/comments or email your comments to
ctiphotline@lucent.com (mailto:ctiphotline@lucent.com).

Customer satisfaction is extremely important to Lucent Technologies.
All users are encouraged to provide feedback on the Navis™ Optical
PM - NP information products.

Administration Guide About this information product

....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002
,

Lucent Technologies x v i i



How to order To order Navis™ Optical PM - NP information products, contact your
Lucent Technologies customer team representative or contact Lucent
Technologies at:

• From the United States, call 888-LUCENT8 (888-582-3688),
prompt 1.

• From Canada, call 317-322-6619.

• From Europe, the Middle East, and Africa, call 317-322-6416.

• From Asia, the Pacific Region, China, the Caribbean, and Latin
America, call 317-322-6411.

Administration Guide About this information product
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1 Administration Overview

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides an overview of the administration of the Navis™

Optical PM - NP System.

Administration Categories The Navis™ Optical PM - NP System encompasses two types of
administration categories.

The two types of administrative categories are the following:

• Platform Administration, which contains critical platform setup
tasks that are performed outside of the Navis™ Optical PM - NP
application. This category includes tasks for powering on or
powering off workstations, adding users to workstations, and
assigning user privileges.

• Navis™ Optical PM - NP Administration, which includes tasks
and concepts that are specific to this software application.

Contents
What is administration? 1-2

Who performs administration tasks? 1-3

Hardware Configurations 1-4
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What is administration?
....................................................................................................................................................................................................................................

Introduction Administration of the Navis™ Optical PM - NP System includes the
management of users and system security.

Administration process The administration process provides the following types of support to
the Navis™ Optical PM - NP System and the network:

• security management support

• provisioning support

• system support

Security management Security management support includes tasks associated with how to
add and delete user IDs and profiles.

Provisioning support Provisioning support includes tasks used to list network elements.

System support System support includes system-related tasks, such as how to back up
or recover the system.

Administration Overview
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Who performs administration tasks?
....................................................................................................................................................................................................................................

Introduction Administrative tasks are performed by users who have a system
administrator user type.

System administrator user
types

The Navis™ Optical PM - NP System has the following types of
system administrators who use the system:

• The Navis™ Optical PM - NP System Administrator is the
dacscan user who has privileges to start or stop the Navis™

Optical PM - NP System.

• The Navis™ Optical PM - NP Administrator is the application
administrator whose user type is sa, which is the default
administrator user ID that automatically resides in the Navis™

Optical PM - NP database as the first real user. The Navis™

Optical PM - NP administrator can create other Navis™ Optical
PM - NP application users, including those who have sa
privileges and can assign flexible permissions to permit/restrict
user access to the application’s forms.

• The OS (Operating System) Superuser is the hardware
administrator for the UNIX or the Windows system who has
ultimate power over UNIX or Windows hardware, and is known
as root or Administrator, respectively.

Functions Users who have system administrator privileges are able to perform
tasks that enable them to:

• provide security management, provisioning, and system support
to the Navis™ Optical PM - NP host and to the Network Map

• control the appearance of the Network Map

Administration Overview
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Hardware Configurations
....................................................................................................................................................................................................................................

Introduction The Navis™ Optical PM - NP System supports various hardware
configurations.

List of hardware
configurations

The following hardware configurations are supported:

• single server

• single server with disk mirroring

Refer to the Navis™ Optical PM - NP Provisioning Guide for details.

Administration Overview
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2 Platform Administration

Overview
....................................................................................................................................................................................................................................

Purpose

This chapter contains information on how to:

• use common UNIX commands

• power on/power down servers

• power on/power down desktops—HP workstations and PCs

• perform configuration setup tasks

• manage users on client/server workstations residing on HP-UX
and Windows platforms

• create and delete SAGE workstation users

• add a printer

• power down desktops—HP workstations and Windows PC

• power down HP and Windows servers

Contents
Section I: Common UNIX Commands 2-4

init command to change the run level of the
application

2-5

who command to verify the system run level 2-6

....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002

Lucent Technologies 2 - 1



init and who commands to clear the buffers on
single servers

2-7

ping command to verify communication with a
remote system

2-8

telnet command to initiate a session on a remote
system

2-9

uname command to display system information 2-10

lanscan command to view LAN status 2-11

vgdisplay command to verify mirroring status 2-12

Section II: Power on Servers 2-13

Power on an HP server in a single server
configuration

2-14

Power on a Windows terminal server 2-15

Section III: Power Down Servers 2-16

Power down an HP server in a single server
configuration

2-17

Power down a Windows terminal server 2-19

Section IV: Power on Desktops 2-21

Power on an HP-UX workstation 2-22

Power on a Windows PC 2-23

Section V: Power Down Desktops 2-24

Power down an HP-UX workstation 2-25

Power down a Windows PC 2-27

Section VI: Configuration Tasks 2-28

Add a workstation to the Navis™ Optical PM - NP
host

2-29

TIM TCP/IP configuration setup 2-31

Set up an asynchronous port for the TIM interface 2-34

Section VII: Administering Users 2-37

Create a User ID through SAM’s GUI-based
program

2-38

Create a User ID through SAM’s terminal-based
program

2-42
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Assign user privileges to a user on a Windows PC 2-46

Assign user privileges to a user on a Windows 2000
PC

2-48

Assign system administrator privileges on a
Windows PC

2-50

Add a user on the server 2-52

Set up a user ID for cut-through to the Navis™

Optical EMS
2-53

Section VIII: Administer SAGE Desktop
Integration Users

2-54

Add a user to a SAGE workstation 2-55

Delete a user from a SAGE workstation 2-57

Section IX: Printer Administration 2-58

Install a network printer on a Navis™ Optical PM -
NP server

2-59

Add a network printer 2-61

Add a local serial printer 2-63

Set up the CDE printer icon 2-64
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Section I: Common UNIX Commands

Overview
....................................................................................................................................................................................................................................

Purpose This section describes a few UNIX commands used in the
administration process. Some of these commands are used in this
document’s tasks, while others may be used when there is a need to
access remote systems or to verify network communication status.

Contents
init command to change the run level of the
application

2-5

who command to verify the system run level 2-6

init and who commands to clear the buffers on
single servers

2-7

ping command to verify communication with a
remote system

2-8

telnet command to initiate a session on a remote
system

2-9

uname command to display system information 2-10

lanscan command to view LAN status 2-11

vgdisplay command to verify mirroring status 2-12
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init command to change the run level of the application
....................................................................................................................................................................................................................................

Introduction The init command is used to change the run level of the Navis™

Optical PM - NP application on an HP server. The following describes
two run levels, run level 3 and run level 4.

run level 3 The init 3 command causes the system to switch to run level 3, which
shuts down the Navis™ Optical PM - NP application. For example, the
init 3 command would be entered before creating a trace file or if the
system needs a new software load.

run level 4 The init 4 command causes the system to switch to run level 4, which
starts up the Navis™ Optical PM - NP application. For example, the
init 4 command would be entered after a trace file has been created.
Systems that are configured with an uninterruptible power supply
(UPS) are brought up to run level 4 automatically.

Section I: Common UNIX Commands Platform Administration
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who command to verify the system run level
....................................................................................................................................................................................................................................

Purpose This procedure is used to verify system run level.

Task Use these steps to determine the current run level of the system.
............................................................................................................................................................

1 Log in to the host as root.

............................................................................................................................................................

2 At the prompt, enter who -r

Result:

A message displays a line of current run level information, such
as run-level 3 Dec 30 11:26 3 0 S.

Section I: Common UNIX Commands Platform Administration
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init and who commands to clear the buffers on single servers
....................................................................................................................................................................................................................................

Purpose This procedure is used periodically to clear the buffers on single
servers only.

Task Use these steps to clear the buffers on single servers:
............................................................................................................................................................

1 Log in to the single server as root.

............................................................................................................................................................

2 At the prompt, enter init 3

Result:

The Navis™ Optical PM - NP application is stopped.

............................................................................................................................................................

3 At the prompt, enter who -r

Result:

A message is displayed indicating the current run level and
when the machine was last rebooted, such as run-level 3 Dec

30 11:26 3 0 S.

Section I: Common UNIX Commands Platform Administration
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ping command to verify communication with a remote system
....................................................................................................................................................................................................................................

Description The ping command is used to determine whether it is possible to
communicate with a remote system. Failure to communicate may be
caused by the remote system being switched off or the communication
link not working correctly.

When a user enters ping <host_name> —n 10 at a prompt, output
similar to the following is displayed.

PING <host_name>.lucent.com: 64 byte packets

64 bytes from <ip_address>: icmp_seq=0. time=155. ms

64 bytes from <ip_address>: icmp_seq=1. time=155. ms

64 bytes from <ip_address>: icmp_seq=2. time=155. ms

64 bytes from <ip_address>: icmp_seq=3. time=154. ms

64 bytes from <ip_address>: icmp_seq=4. time=155. ms

64 bytes from <ip_address>: icmp_seq=5. time=154. ms

64 bytes from <ip_address>: icmp_seq=6. time=154. ms

64 bytes from <ip_address>: icmp_seq=7. time=155. ms

64 bytes from <ip_address>: icmp_seq=8. time=155. ms

64 bytes from <ip_address>: icmp_seq=9. time=157. ms

----<host_name> PING Statistics----

10 packets transmitted, 10 packets received, 0% packet

loss round-trip (ms) min/avg/max = 154/154/157

Section I: Common UNIX Commands Platform Administration
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telnet command to initiate a session on a remote system
....................................................................................................................................................................................................................................

Description The telnet command is used to initiate a session on a remote
system. When telnet <system_name> is entered at a prompt, the
system requests the user to type the login ID and password. Once
successfully logged in, the session is active until the user logs off of
the remote system.

Section I: Common UNIX Commands Platform Administration
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uname command to display system information
....................................................................................................................................................................................................................................

Purpose This procedure is used to identify the system with which a terminal is
communicating.

Task Use these steps to display system information.
............................................................................................................................................................

1 Log in to a terminal as root.

............................................................................................................................................................

2 At the prompt, enter uname —a

Result:

A line similar to the following is displayed:

HP-UX <host_name> B.11.00 A 9000/810 2013485357

two-user license.

Section I: Common UNIX Commands Platform Administration
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lanscan command to view LAN status
....................................................................................................................................................................................................................................

Purpose The lanscan command allows you to view the status of any of the
LANs that are connected to the machine, including the LAN that
connects the Navis™ Optical PM - NP to the Navis™ Optical EMS.

Task Use these steps to view LAN status information.
............................................................................................................................................................

1 Using the system console, log in to the primary or the standby host as
root.

............................................................................................................................................................

2 Enter lanscan.

Result:

The LAN status information is displayed.

Section I: Common UNIX Commands Platform Administration
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vgdisplay command to verify mirroring status
....................................................................................................................................................................................................................................

Purpose The vgdisplay command is used to verify that the application and
databases residing on separate disks are synchronized.

About the mirrored disk
configuration

A mirrored disk configuration eliminates having a second server as a
backup. The application and database that reside on separate disks are
mirrored onto a second set of disks. Information that is written to disk
is reflected onto the mirrored counterpart. We recommend that the
mirroring status is checked periodically to ensure that all mirrored
information is synchronized with the primary information.

Before you begin Ensure that the LVSTATUS is set to SYNC.

Task Use these steps to obtain mirroring status:
............................................................................................................................................................

1 Using the system console, log into the primary host as root.

............................................................................................................................................................

2 Enter vgdisplay -v | pg at the # prompt.

Result:

The mirroring status is displayed.

Section I: Common UNIX Commands Platform Administration
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Section II: Power on Servers

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power on HP servers and
a Windows terminal server.

Contents
Power on an HP server in a single server
configuration

2-14

Power on a Windows terminal server 2-15
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Power on an HP server in a single server configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on an HP server in a single server
configuration.

Important! When the system is powered on, it does not
automatically start the Navis™ Optical PM - NP application.

Task Use these steps to power on an HP server in a single server
configuration.
............................................................................................................................................................

1 Power on all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Power on the HP server by pressing the power switch or turning the
key, as appropriate.

Result:

The HP server runs a sequence of diagnostics then boots into
multi-user mode. The server is ready when the Console Login

prompt is displayed on the controlling terminal.

Section II: Power on Servers Platform Administration
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Power on a Windows terminal server
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on a Windows terminal server.

Task Use these steps to power on a Windows terminal server.
............................................................................................................................................................

1 Power on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Power on the HP server by pressing the power switch or turning the
key, as appropriate.

Result:

The server runs a sequence of diagnostics and is ready for input
when the Windows login dialog box is displayed.

Section II: Power on Servers Platform Administration
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Section III: Power Down Servers

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power down HP servers
and a Windows terminal server.

Contents
Power down an HP server in a single server
configuration

2-17

Power down a Windows terminal server 2-19
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Power down an HP server in a single server configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to power down an HP server in a single server
configuration.

Before you begin Before you begin this task, be sure that the Navis™ Optical PM - NP
application has been shut down. See “Stop the Navis™ Optical PM -
NP application on a single server” (3-14).

Task Complete the following task to power down a single server.
............................................................................................................................................................

1 On the control terminal, log in as root.

............................................................................................................................................................

2 At the prompt, type cd /

Result:

The directory is changed.

............................................................................................................................................................

3 At the prompt, type shutdown -h -y 0

Result:

The shutdown process initiates and eventually displays the
following message:

System has halted
OK to turn off power or reset system
UNLESS 'wait for UPS to turn off power' message was

printed above

............................................................................................................................................................

4 Power off the HP server by pressing the power switch or turning the
key.

Result:

The HP server is powered off.

............................................................................................................................................................

5 Power off all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

Section III: Power Down Servers Platform Administration

....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002

Lucent Technologies 2 - 1 7



Result:

All associated peripherals are powered off.

Section III: Power Down Servers
Power down an HP server in a single server
configuration
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Power down a Windows terminal server
....................................................................................................................................................................................................................................

Purpose This procedure is used to power down a Windows terminal server.

Before you begin Be sure that the Navis™ Optical PM - NP application has been shut
down.

Task Use these steps to power down a Windows terminal server.
............................................................................................................................................................

1 Log in to the Windows terminal server as Administrator.

............................................................................................................................................................

2 Press the Ctrl, Alt, and Del buttons.

Result:

The Windows Security dialog box is displayed.

............................................................................................................................................................

3 Press the Shut Down button.

Result:

The Shut Down Windows dialog box is displayed.

............................................................................................................................................................

4 Select the Shut Down radio button.

Result:

The Shutdown Computer dialog box is displayed.

............................................................................................................................................................

5 Select the OK radio button.

Result:

The Windows terminal server powers down.

............................................................................................................................................................

6 Power off the terminal server by pressing the power switch or turning
the key.

Result:

The terminal server is powered off.

Section III: Power Down Servers Platform Administration
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............................................................................................................................................................

7 Power off all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

Result:

All associated peripherals are powered off.

Section III: Power Down Servers
Power down a Windows terminal server
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Section IV: Power on Desktops

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power on user desktops,
which are HP workstations and Windows PCs.

Contents
Power on an HP-UX workstation 2-22

Power on a Windows PC 2-23

Platform Administration
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Power on an HP-UX workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on an HP-UX workstation.

Task Use these steps to power on an HP-UX workstation.
............................................................................................................................................................

1 Power on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Power on the workstation—press the power switch or turn the key, as
appropriate.

Result:

The workstation runs a sequence of diagnostics and then boots
to the X-Windows system. The workstation is ready when the
Common Desktop Environment (CDE) login dialog box is
displayed.

Section IV: Power on Desktops Platform Administration
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Power on a Windows PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on a Windows PC.

Task Use these steps to power on a Windows PC.
............................................................................................................................................................

1 Power on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Power on the PC—press the power switch or turn the key, as
appropriate.

Result:

The PC runs a sequence of diagnostics. The PC is ready when
the Windows login dialog box is displayed.

Section IV: Power on Desktops Platform Administration
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Section V: Power Down Desktops

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power down HP
workstations and Windows desktops.

Contents
Power down an HP-UX workstation 2-25

Power down a Windows PC 2-27
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Power down an HP-UX workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to power down an HP-UX workstation.

Before you begin Be sure that the Navis™ Optical PM - NP application has been shut
down. See “Stop the Navis™ Optical PM - NP application on the User
Interface” (3-13).

Task Use these steps to power down an HP-UX workstation.
............................................................................................................................................................

1 Log in to the workstation as root.

............................................................................................................................................................

2 At the prompt, type cd /

Result:

The directory is changed.

............................................................................................................................................................

3 At the prompt, type shutdown -h -y 0

Result:

The shutdown process initiates and eventually displays the
following message:

System has halted
OK to turn off power or reset system
UNLESS 'wait for UPS to turn off power' message was

printed above

............................................................................................................................................................

4 Power off the workstation by pressing the power switch or turning the
key.

Result:

The workstation is powered off.

............................................................................................................................................................

5 Power off all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

Section V: Power Down Desktops Platform Administration
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Result:

All associated peripherals are powered off.

Section V: Power Down Desktops
Power down an HP-UX workstation
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Power down a Windows PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to power down a Windows PC.

Before you begin Be sure that the Navis™ Optical PM - NP application has been shut
down. See “Stop the Navis™ Optical PM - NP application on the User
Interface” (3-13).

Task Use these steps to power down a Windows PC.
............................................................................................................................................................

1 Log in to the PC as Administrator.

............................................................................................................................................................

2 Select Start > Shut Down.

Result:

The Shut Down Windows dialog box is displayed.

............................................................................................................................................................

3 Select the Shut Down radio button then select Yes.

Result:

The Windows PC powers down.

............................................................................................................................................................

4 Power off the PC by pressing the power switch or turning the key.

Result:

The PC is powered off.

............................................................................................................................................................

5 Power off all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

Result:

All associated peripherals are powered off.

Section V: Power Down Desktops Platform Administration
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Section VI: Configuration Tasks

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks that explain how to configure Navis™

Optical PM - NP hardware and how to set up supporting processes.

Contents
Add a workstation to the Navis™ Optical PM - NP
host

2-29

TIM TCP/IP configuration setup 2-31

Set up an asynchronous port for the TIM interface 2-34

Platform Administration
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Add a workstation to the Navis™ Optical PM - NP host
....................................................................................................................................................................................................................................

Purpose Use these steps to add a workstation to the Navis™ Optical PM - NP
host.

Task Use these steps to add a workstation to the Navis™ Optical PM -
NP host.
............................................................................................................................................................

1 Log in to the Navis™ Optical PM - NP host as root.

............................................................................................................................................................

2 At the prompt, enter ksh /install/add.ethers

............................................................................................................................................................

3 At the prompt, enter y and press Enter.

............................................................................................................................................................

4 At the prompt, enter the workstation name and press Enter.

............................................................................................................................................................

5 Enter y to confirm that the name was entered correctly then press
Enter.

............................................................................................................................................................

6 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

............................................................................................................................................................

8 Log in to the workstation.

............................................................................................................................................................

9 At the prompt, enter pg /etc/hosts.

Result:

A page of information is displayed.

Section VI: Configuration Tasks Platform Administration
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............................................................................................................................................................

10 View the display to determine if an entry exists for the workstation.

..........................................................................................................................................................

11 IF THEN

an entry exists, proceed to the next step.

an entry does not exist, add the workstation information to the
bottom of the /etc/hosts file.

............................................................................................................................................................

12 Download the Navis™ Optical PM - NP GUI.

Result:

The GUI is downloaded.

Section VI: Configuration Tasks
Add a workstation to the Navis™ Optical
PM - NP host
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TIM TCP/IP configuration setup
....................................................................................................................................................................................................................................

Purpose Use these steps to set up a TNM Integration Module (TIM) TCP/IP
configuration.

Task Use these steps to set up a TIM TCP/IP configuration.
............................................................................................................................................................

1 Log in to the host as root.

............................................................................................................................................................

2 At the prompt, enter init 3

Result:

The Navis™ Optical PM - NP application is stopped.

............................................................................................................................................................

3 At the prompt, enter cd /etc/dscan

touch .tim

chmod 666 .tim

Result:

The file’s timestamp is updated and its permissions are changed.

............................................................................................................................................................

4 At the prompt, enter /etc/dscan/chg_env_var

Result:

The following message is displayed:
THE DEFAULT SETTINGS FOR <COMPANY_NAME> WILL NOW BE

DISPLAYED
YOU WILL BE PROMPTED TO CONFIRM THE SETTINGS.
ENTER TO CONTINUE:

............................................................................................................................................................

5 Press Enter.

Result:

A list of settings is displayed with a prompt requesting if you
want to change the settings.

............................................................................................................................................................

6 Type y and press Enter to continue.
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Result:

The WS-NMS Parameter Editor menu is displayed.

............................................................................................................................................................

7 View the menu until you see the number corresponding to TIM_PORT

or TIM_TCP.

Important! You may have to press Enter to view this selection.

............................................................................................................................................................

8 At the prompt, enter the number corresponding to TIM_PORT or
TIM_TCP.

Result:

The selection is displayed.

............................................................................................................................................................

9 At the prompt, enter 2 and press Enter.

Result:

You are prompted to enter the IP address for TIM.

............................................................................................................................................................

10 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

11 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the TIM hostname.

............................................................................................................................................................

12 Enter the hostname, then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

13 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Section VI: Configuration Tasks
TIM TCP/IP configuration setup

Platform Administration

....................................................................................................................................................................................................................................

2 - 3 2 Lucent Technologies 365-314-102R1.0
Issue 1, April 2002



Result:

The following messages should be displayed followed by a
prompt to add or change the TIM Interface login and password.

Updated host's file successfully

Updated CCP file successfully

............................................................................................................................................................

14 Add or change the password as required.

Result:

The following message is displayed.

Updated TIM login file successfully

............................................................................................................................................................

15 Press Enter to return to the edit parameter menu and then type q and
press Enter and type n and press Enter.

Result:

You have exited the menu.

............................................................................................................................................................

16 Log in to the host as dacscan.

............................................................................................................................................................

17 Copy the parameters to the following file in the database:
/usr/dacscan/bin/DBinitParam

Result:

A list of parameters is displayed without entries for TIM_PORT

and TIM_TCP.

............................................................................................................................................................

18 Log in to the host as root.

............................................................................................................................................................

19 At the prompt, enter init 4

Result:

The Navis™ Optical PM - NP application is started.
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Set up an asynchronous port for the TIM interface
....................................................................................................................................................................................................................................

Purpose Use this procedure to set up an asynchronous port for the TIM
interface.

Task Use these steps to set up an asynchronous port.
............................................................................................................................................................

1 Log in to the host as root.

............................................................................................................................................................

2 At the prompt, enter sam then press Enter

Result:

The SAM program begins.

............................................................................................................................................................

3 View the display, highlight Peripheral Devices ->, then press Enter.

Result:

A new menu is displayed.

............................................................................................................................................................

4 Highlight Terminals and Modems then press Enter.

Result:

The current configuration is displayed.

............................................................................................................................................................

5 Press F4.

Result:

The main menu bar is activated.

............................................................................................................................................................

6 Select Actions then press Enter.

Result:

A drop down menu is displayed.

............................................................................................................................................................

7 Select Add Modems then press Enter.

Result:

A note menu is displayed.
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............................................................................................................................................................

8 Select OK.

Result:

A hardware scan will take place and eventually return with the
installed Mux/Serial cards and their respective hardware paths.

............................................................................................................................................................

9 Highlight Mux/Serial card with a h/w path of 12 then press tab three
times.

............................................................................................................................................................

10 Enter the port number, press tab once, then enter 9600 for the baud
rate.

............................................................................................................................................................

11 Press tab once, then unselect Do you want the device for

calling out? Use defaults for all other prompts, then press F5.

Result:

A device file is created, for example for port 3:

/dev/ttyd0p3

............................................................................................................................................................

12 Write down the displayed device information then exit sam.

............................................................................................................................................................

13 At the prompt, enter vi /etc/inittab and press Enter.

Result:

The file is displayed.

............................................................................................................................................................

14 Locate a0:2:respawn:/etc/getty -h ttyd0p3 9600 then change
the line to a0:24:respawn:/etc/getty -h ttyd0p3 9600

............................................................................................................................................................

15 Press Esc, then type :wq

Result:

The file is saved.

............................................................................................................................................................

16 At the prompt, enter init q then press Enter.
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Result:

The changed is initialized.
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Section VII: Administering Users

Overview
....................................................................................................................................................................................................................................

Purpose This section contains the tasks needed to create user IDs using a
GUI-based or terminal-based version of HP’s System Administration
Manager (SAM) program. It includes tasks for assigning user or
administrator privileges on a Windows PC and a task for setting up a
user ID for cut-through to the Navis™ Optical EMS.

Contents
Create a User ID through SAM’s GUI-based
program

2-38

Create a User ID through SAM’s terminal-based
program

2-42

Assign user privileges to a user on a Windows PC 2-46

Assign user privileges to a user on a Windows 2000
PC

2-48

Assign system administrator privileges on a
Windows PC

2-50

Add a user on the server 2-52

Set up a user ID for cut-through to the Navis™

Optical EMS
2-53
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Create a User ID through SAM’s GUI-based program
....................................................................................................................................................................................................................................

Purpose This procedure is used to create a user ID through the GUI-based
version of the SAM program using an HP-UX workstation.

Task Use these steps to create an application user ID through SAM
using an HP-UX workstation.
............................................................................................................................................................

1 Log in to the workstation as root.

............................................................................................................................................................

2 On the Common Desktop Environment (CDE) panel (at the bottom of
the screen), select the terminal icon to open a dtterm window.

Result:

A dtterm window is displayed.

............................................................................................................................................................

3 At the prompt, enter sam and then press Enter.

Result:

The System Administration Manager window’s SAM Areas is
displayed.

............................................................................................................................................................

4 Double click the Accounts for Users and Groups icon.

Result:

The Accounts for User and Groups icons is displayed.

............................................................................................................................................................

5 Double click the Local Users icon.

Result:

The Account for Users and Group form is displayed.

............................................................................................................................................................

6 Select Actions > Add.

Result:

The Add a User Account form is displayed.
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............................................................................................................................................................

7 In the Login Name field, enter a value of up to 8 characters
representing the ID (such as the person’s abbreviated name) .

Important! The valid characters allowed in the ID are lowercase
letters (a-z), numbers (0-9), and one or more underscores (_). The
first character must be a lowercase letter. The underscores may
be in any position after the first.

Result:

The Home directory field displays the directory path, which
includes the Login Name field’s value, such as
/home/<login_name>.

............................................................................................................................................................

8 At the Create Home directory field, select the box.

Important! The Create Home Directory box must be selected to
add the user successfully. If this box is not checked, a corruption
may occur in the /etc/passwd file that causes the computer to
boot up in single user mode.

............................................................................................................................................................

9 In the Primary Group Name field, enter dba or users.

Important! In most cases, dba is selected. User IDs within the
users group may be restricted from performing certain functions.

............................................................................................................................................................

10 In the Start-up Program field, enter /usr/bin/ksh.

Important! The remaining information is optional.

............................................................................................................................................................

11 Optional: complete the remaining fields, then select the Set Passwords
Option button.

Result:

The Password Options form is displayed.

............................................................................................................................................................

12 At the Password Options field, choose an option from the list, then
select OK.
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Result:

The Password Options form closes and the Add a User Account
window is displayed again.

............................................................................................................................................................

13 Select OK to continue.

Result:

The Set User Password dialog box is displayed.

............................................................................................................................................................

14 Enter a password for the user ID, then click OK.

Result:

A verification message is displayed.

............................................................................................................................................................

15 Re-enter a password for the user ID, then click OK.

Result:

A message is displayed confirming that the user ID has been
added.

............................................................................................................................................................

16 To exit the Add a User Account form, select File > Exit.

Result:

The Accounts for Users and Groups form displays the new user
ID.

............................................................................................................................................................

17 To exit the Accounts for Users and Groups form, select File > Exit
SAM.

............................................................................................................................................................

18 At the prompt, type cat /etc/passwd | pg, then view the display to
determine if permissions have been properly set for the created user
ID in the passwd file.

............................................................................................................................................................

19 For each user entered in the Login Name field in Step 7 of this task,
use the “Add a user” (4-4) task to add the user to the Navis™ Optical
PM - NP application.
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Important! If this new user ID is used for cut-through access to
an EMS, the user ID must be added to the EMS’s GUI. See “Set
up a user ID for cut-through to the Navis™ Optical EMS” (2-53)
for details.
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Create a User ID through SAM’s terminal-based program
....................................................................................................................................................................................................................................

Purpose This procedure is used to create a user ID through the terminal
(non-GUI) version of the SAM program, which may be accessed
through a telnet session.

Task Use these steps to create a user ID by accessing SAM through a
telnet session.
............................................................................................................................................................

1 Log in to a workstation.

............................................................................................................................................................

2 Click the Start button in the taskbar, then select Run.

Result:

The Run dialog box is displayed.

............................................................................................................................................................

3 In the Run dialog box’s Open field, enter telnet <ip_address> or
<host name> and log in as root to the host server that contains the
SAM program .

............................................................................................................................................................

4 At the prompt, type sam and press Enter.

Result:

A message is displayed indicating that the terminal version of
SAM is started.

............................................................................................................................................................

5 Press Enter.

Result:

The Sam Administration Manager form is displayed.

............................................................................................................................................................

6 At the highlighted Accounts for Users and Groups selection, press
Enter.

Result:

A menu of User and Group options is displayed.
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............................................................................................................................................................

7 Using the down arrow key, highlight the Users item and press Enter.

Result:

The Accounts for Users and Groups form is displayed.

............................................................................................................................................................

8 Using the Tab and arrow keys, scroll to the Actions menu selection,
then press Enter.

Result:

The Actions menu is displayed.

............................................................................................................................................................

9 At the highlighted Add... entry, press Enter.

Result:

The Add a User Account form is displayed.

............................................................................................................................................................

10 In the Login Name field, enter a value of up to 8 characters
representing the ID (such as the person’s abbreviated name) and press
Enter.

Important! The valid characters allowed in the ID are lowercase
letters (a-z), numbers (0-9), and one or more underscores (_). The
first character must be a lowercase letter. The underscores may
be in any position after the first.

Result:

The cursor bypasses the User ID (UID) field, which is already
populated with a system-generated entry. The Home directory
field displays the directory path, which includes the Login Name
field’s value, such as /home/<login_name>.

............................................................................................................................................................

11 Tab to the Create Home Directory check box, then press Enter if an
X is not already displayed in the box.

Important! The Create Home Directory box must be checked to
add the user successfully. If this box is not checked, a corruption
may occur in the /etc/passwd file that causes the computer to
boot up in single user mode.
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............................................................................................................................................................

12 Tab to the Primary Group Name field, type dba or users and press
Enter.

Important! In most cases, dba is entered. User IDs within the
users group may be restricted from performing certain functions.

............................................................................................................................................................

13 In the Start-Up Program field, enter /usr/bin/ksh and press Enter.

Result:

The Start-Up Program field contains the selected entry.

............................................................................................................................................................

14 Optional: complete the remaining fields; tab to Set Password
Options; and press Enter.

Result:

The Password Options dialog box displays.

............................................................................................................................................................

15 Press Enter to display the list of password options, scroll to your
selection, press Enter, tab to OK, then press Enter.

Result:

The Password Options dialog box closes.

............................................................................................................................................................

16 Tab to OK and press Enter.

Result:

The Set User Password dialog box is displayed.

............................................................................................................................................................

17 Enter a password, then press Enter.

Result:

A verification message is displayed.

............................................................................................................................................................

18 Re-enter a password, tab to OK, then press Enter.

Result:

A message confirms that the login has been added.
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............................................................................................................................................................

19 To exit the Add a User Account form, tab to the File menu, highlight
Exit , then press Enter.

Result:

The Accounts for Users and Groups form is displayed.

............................................................................................................................................................

20 To exit the Accounts for Users and Groups form, tab to the File menu,
highlight Exit SAM, then press Enter.

............................................................................................................................................................

21 At the prompt, type cat /etc/passwd | pg then view the display to
determine if permissions have been properly set for the created user
ID in the passwd file.

............................................................................................................................................................

22 At the prompt, type exit.

Result:

A logout root and telnet status message is displayed.

............................................................................................................................................................

23 For each user entered in the Login Name field in Step 10 of this task,
perform the “Add a user” (4-4) task to add the user to the Navis™

Optical PM - NP application.

Important! If this new user ID is used for cut-through access to
an EMS, the user ID must be added to the EMS GUI. See “Set
up a user ID for cut-through to the Navis™ Optical EMS” (2-53)
for details.
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Assign user privileges to a user on a Windows PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to assign user privileges to a user on a PC
running Windows software.

Before you begin The user ID must be created.

Permissions You must have system administrator privileges on the PC to perform
this task.

Task Use these steps to assign user privileges to a user on a Windows
PC.
............................................................................................................................................................

1 On the Windows main window, click on the Start button in the task
bar.

Result:

A menu is displayed.

............................................................................................................................................................

2 Select Programs > Administrative Tools (Common) > User
Manager.

Result:

The User Manager window is displayed.

............................................................................................................................................................

3 From the User Manager window, select User > New User.

Result:

The New User window is displayed.

............................................................................................................................................................

4 Complete the required Username field and the optional Full Name
and Description fields.

............................................................................................................................................................

5 In the Password field, enter the password associated with the new
user ID.
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............................................................................................................................................................

6 In the Confirm Password field, enter the same password.

............................................................................................................................................................

7 Optional: Uncheck User Must Change Password at Next Logon
box.

............................................................................................................................................................

8 Optional: Check the Password Never Expires box.

............................................................................................................................................................

9 Select the Groups button.

Result:

The Group Membership screen is displayed.

............................................................................................................................................................

10 On the Group Membership screen, view the Member of list for a
Users entry. If Users is not listed, highlight Users in the Not
Member of list and select the Add button.

Important! If an entry other than Users displays in the Member
of list, highlight the entry, then select the Remove button to
move the entry to the Not Member of list.

Result:

Users displays in the Member of list.

............................................................................................................................................................

11 On the Group Membership screen, select OK.

Result:

The Group Membership screen closes.

............................................................................................................................................................

12 On the New User screen, select OK.

Result:

The New User screen closes and the new user is listed on the
User Manager screen.
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Assign user privileges to a user on a Windows 2000 PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to assign user privileges to a user on a PC
running Windows 2000 software.

Before you begin Be sure that the user ID has been created.

Permissions You must have system administrator privileges on the PC to perform
this task.

Task Use these steps to assign user privileges to a user on a Windows
2000 PC.
............................................................................................................................................................

1 Log in to a workstation as an administrator.

............................................................................................................................................................

2 In the task bar, click the Start button, and then select Settings >
Control Panel.

Result:

The Control Panel form is displayed.

............................................................................................................................................................

3 Double click the Users and Passwords icon.

Result:

The Users and Passwords form is displayed.

............................................................................................................................................................

4 Click the Add button.

Result:

The Add New User form is displayed.

............................................................................................................................................................

5 Complete the User name, Full name, and Description fields, and
then click the Next button.

Result:

The Add New User form displays the password fields.
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............................................................................................................................................................

6 Complete the Password and Confirm Password fields, and then
click the Next button.

Result:

The Add New User form displays access selections.

............................................................................................................................................................

7 Click Standard user (or other desired level of access), and then click
the Finish button.

Result:

The user is added.
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Assign system administrator privileges on a Windows PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to assign system administrator privileges to a
user on a Windows PC.

Before you begin Be sure that the user ID has been created.

Permissions You must be authorized to perform this task.

Tasks Use these steps to create a system administrator login and assign
system administrator privileges on a Windows PC.
............................................................................................................................................................

1 On the Windows main window, click on the Start button in the task
bar.

Result:

A menu is displayed.

............................................................................................................................................................

2 Select Programs > Administrative Tools (Common) > User
Manager.

Result:

The User Manager window is displayed.

............................................................................................................................................................

3 From the User Manager window, select User > New User.

Result:

The New User window is displayed.

............................................................................................................................................................

4 Complete the required Username field and the optional Full Name
and Description fields.

............................................................................................................................................................

5 In the Password field, enter the password associated with the new
user ID.

............................................................................................................................................................

6 In the Confirm Password field, enter the same password.
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............................................................................................................................................................

7 Uncheck User Must Change Password at Next Logon box.

............................................................................................................................................................

8 Check the Password Never Expires box.

............................................................................................................................................................

9 Select the Groups button.

Result:

The Group Membership screen is displayed.

............................................................................................................................................................

10 On the Group Membership screen, view the Member of list for an
Administrators entry. If Administrators is not listed, highlight
Administrators in the Not Member of list and select the Add button.

Important! If an entry other than Administrators is displayed
in the Member of list, highlight the entry and select the Remove
button to move the entry to the Not Member of list.

Result:

Administrators is displayed in the Member of list.

............................................................................................................................................................

11 On the Group Membership screen, select OK.

Result:

The Group Membership screen closes.

............................................................................................................................................................

12 On the New User screen, select OK.

Result:

The New User screen closes and the new user is listed on the
User Manager screen.
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Add a user on the server
....................................................................................................................................................................................................................................

Note There is no need to add any new users on the server. Any necessary
User IDs should have already been loaded with the software.
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Set up a user ID for cut-through to the Navis™ Optical EMS
....................................................................................................................................................................................................................................

Purpose This procedure is used to set up a user ID for cut-through to the
Navis™ Optical EMS application.

A cut-through user ID can be created and used for Navis™ Optical PM
- NP to Navis™ Optical EMS connections.

Task Use these steps to add a cut-through user ID to Navis™ Optical
EMS.
............................................................................................................................................................

1 Add a cut-through user ID to Navis™ Optical EMS. See the Navis™

Optical EMS Administration Guide for details.

............................................................................................................................................................

2 Enable the user option in the Secure Access Gateway for Enterprises
(SAGE) feature. See the Secure Access Gateway for Enterprises
(SAGE) Administration Guide.
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Section VIII: Administer SAGE Desktop Integration Users

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the Secure Access Gateway
for Enterprises (SAGE) Desktop Integration feature.

Definition: SAGE Desktop
Integration

SAGE Desktop Integration is an optional feature for Navis™ Optical
PM - NP applications that allows users to access multiple Navis™

Optical PM - NP systems through a web browser.

A system administrator may add or delete SAGE users to/from an
HP-UX client workstation.

Since SAGE requires each user to have an individual profile, the
system administrator needs to manage these, along with user logins
and passwords. The administrator also needs to support users with
how to Log in to SAGE, how to change passwords, how to modify
user attributes, and how to interpret and respond to system messages.

Related information For more detailed system administration instructions, see the Secure
Access Gateway for Enterprises (SAGE) Administration Guide.
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Add a user to a SAGE workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user to a SAGE workstation.

Task Use these steps to add a user to a SAGE client workstation.
............................................................................................................................................................

1 Log in to the SAGE client workstation as system administrator.

............................................................................................................................................................

2 Click on the IWS icon.

Result:

The IWS HOME PAGE form is displayed.

............................................................................................................................................................

3 Click on the NMS icon.

Result:

The Navis™ Optical NMS Network Module form is displayed.

............................................................................................................................................................

4 Select Administration > Security Assignments> Users > Add.

Result:

The Add User form is displayed.

............................................................................................................................................................

5 In the User ID field, type sawg, then click OK.

............................................................................................................................................................

6 Optional: in the Description field, enter a description to be associated
with the user ID.

............................................................................................................................................................

7 In the Profile field’s drop-down list, select Combined Profile.

Result:

The selected profile is displayed and the tasks associated with
the profile selection are displayed in the Assigned Tasks area
of the window.
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............................................................................................................................................................

8 In the User Type field, select Regular User.

............................................................................................................................................................

9 Click Apply.

Result:

A message at the bottom of the Add User form indicates that the
user is added to the SAGE workstation.

............................................................................................................................................................

10 Click OK.

Result:

The Add User form closes.

............................................................................................................................................................

11 Type the user ID in the User ID field and click OK.

Result:

The user ID is added to the SAGE workstation.
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Delete a user from a SAGE workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user from a SAGE workstation.

Task Use these steps to delete a user from a SAGE workstation.
............................................................................................................................................................

1 Log in to the SAGE workstation as system administrator.

............................................................................................................................................................

2 Bring up the Navis™ Optical NMS Network Map.

Result:

The Navis™ Optical NMS Network Map is displayed.

............................................................................................................................................................

3 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form is displayed.

............................................................................................................................................................

4 Highlight the user ID to be deleted.

............................................................................................................................................................

5 From the Actions menu, select Delete User.

Result:

A confirmation box asks if you really want to delete this user.

............................................................................................................................................................

6 Click Yes.

Result:

The user ID is deleted.

............................................................................................................................................................

7 Select File > Close.

Result:

The List of Users form closes.
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Section IX: Printer Administration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add a network or local serial printer and
how to set up the Common Desktop Environment (CDE) printer icon.

Contents
Install a network printer on a Navis™ Optical PM -
NP server

2-59

Add a network printer 2-61

Add a local serial printer 2-63

Set up the CDE printer icon 2-64
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Install a network printer on a Navis™ Optical PM - NP server
....................................................................................................................................................................................................................................

Purpose This procedure is used to install a network printer on a Navis™

Optical PM - NP server.

Before you begin Before you begin this task, collect the following information about the
network printer from the system administrator and/or by printing the
test/configuration page from the printer.

• Printer name

• IP Address

• LAN Hardware Address

• Name or IP address of the server providing spooler facilities

Task Use these steps to add a network printer on a Navis™ Optical PM
- NP server.
............................................................................................................................................................

1 Take the printer off-line.

............................................................................................................................................................

2 Press the Menu button until TEST MENU is displayed.

............................................................................................................................................................

3 Press the Item button until SELF TEST is displayed.

............................................................................................................................................................

4 Press Enter.

Result:

A printer status sheet prints. This status sheet indicates the LAN
hardware address (LAN HW ADDRESS), network peripheral
name (HOST NAME), and the IP address, if these values have
been assigned to the printer.

............................................................................................................................................................

5 Press On Line.

............................................................................................................................................................

6 Using the system console, log in as root on the primary server via the
system console.
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............................................................................................................................................................

7 Enter ksh /install/prtinstall at the # prompt.

Result:

Additional prompts are displayed.

............................................................................................................................................................

8 Respond to the IP address, printer name, and Type in the LAN

Hardware Address prompts.

Result:

The network printer is added.

Section IX: Printer Administration
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Add a network printer
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a network printer to your workstation.

Before you begin Before you begin this task, collect the following information:

• Printer name (the printer name must be six characters or less)

• IP Address

The network printer must be connected to Ethernet. The local serial
printer must be connected to the asynchronous multiplexer board.

Task Use these steps to add a network printer.
............................................................................................................................................................

1 Take the printer off-line.

............................................................................................................................................................

2 Press the Menu button until TEST MENU is displayed.

............................................................................................................................................................

3 Press the Item button until SELF TEST is displayed.

............................................................................................................................................................

4 Press Enter.

Result:

A printer status sheet prints. This status sheet indicates the LAN
hardware address (LAN HW ADDRESS), network peripheral
name (HOST NAME), and the IP address, if these values have
been assigned to the printer.

............................................................................................................................................................

5 Press On Line.

............................................................................................................................................................

6 Using the system console, log in as root on the primary server via the
system console.

............................................................................................................................................................

7 Enter ksh /install/prtinstall at the # prompt.

Result:

Additional prompts are displayed.
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............................................................................................................................................................

8 Respond to the IP address, printer name, and Type in the LAN

Hardware Address prompts.

Result:

The network printer is added.
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Add a local serial printer
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a local serial printer.

Before you begin Know the printer name. It must be six characters or less.

Task Use these steps to add a local serial printer to your workstation.
............................................................................................................................................................

1 Using the system console, log in as root onto the primary server.

............................................................................................................................................................

2 Enter ksh /install/prtinstall at the # prompt.

............................................................................................................................................................

3 Answer the questions as appropriate.

Result:

The local serial printer is added.
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Set up the CDE printer icon
....................................................................................................................................................................................................................................

Purpose This procedure is used to configure a workstation to print Navis™

Optical PM - NP forms to a local printer. The workstation can be
configured to enable the Common Desktop Environment (CDE)
printer icon to be used to print Navis™ Optical PM - NP forms to a
local printer.

Task Use these steps to set up the CDE printer icon.
............................................................................................................................................................

1 Log in as root.

............................................................................................................................................................

2 Enter cd /config at the UNIX prompt.

............................................................................................................................................................

3 Enter vi sys.vuewmrc

............................................................................................................................................................

4 Change the PUSH_ACTION variable in the “CONTROL Printer” section
to PUSH_ACTION f.action PrintPush

............................................................................................................................................................

5 Save the file.

............................................................................................................................................................

6 Exit the file.

............................................................................................................................................................

7 Enter cd /usr/vue/config/types

............................................................................................................................................................

8 Enter vi PrintPush.vf

............................................................................................................................................................

9 Change the EXEC-STRING variable in the Action PrintPush section
to EXEC-STRING bin/ksh -c ’xwd -frame | xpr -device ps
-cutoff 70 -rv | lp -o nb -o postscript’

............................................................................................................................................................

10 Save the file.
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............................................................................................................................................................

11 Exit the file.

............................................................................................................................................................

12 Select Exit on the CDE to reboot the workstation.

Result:

The workstation is rebooted.
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3 System Administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes tasks performed to administer the Navis™

Optical PM - NP application.

Contents
Section I: Start the Navis™ Optical PM - NP
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3-4
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3-5
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3-7

Section II: Start the Navis™ Optical PM - NP
Application on the User Interface

3-8
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Windows terminal server

3-9

Start the Navis™ Optical PM - NP application on an
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3-10

Start the Navis™ Optical PM - NP application on a
Windows PC

3-11

Section III: Stop the Navis™ Optical PM - NP
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3-12
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Stop the Navis™ Optical PM - NP application on
the User Interface

3-13

Stop the Navis™ Optical PM - NP application on a
single server

3-14

Stop the Navis™ Optical PM - NP application on a
Windows terminal server

3-16

Stop the Navis™ Optical PM - NP application on a
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3-17
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3-18
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Stop the Oracle database 3-20
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View the root cron file 3-24

Edit the system cron file 3-25

Section VI: Monitor Space 3-26

Spacewatch 3-27

Section VII: Administer Performance Monitoring
Data Export

3-28

Performance Monitoring Data Export Variables 3-29

Display Performance Monitoring Data Export
variable settings

3-30

Change the scheduled run time of the Performance
Monitoring Data Export file transfer

3-31

Workstation set up for data export task 3-32

Execute the Performance Monitoring Data Export
tool

3-34

Section VIII: Network Map 3-36
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Section IX: Administer the TIM Northbound
Alarm Interface
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alarms

3-45
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Section I: Start the Navis™ Optical PM - NP Application on the
HP Servers

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to start Navis™ Optical PM - NP server
application.

Background The initial step to start the application is to power on the server. (See
the power on tasks in Chapter 2, “Platform Administration”.) A
single-server configuration may or may not contain mirrored disks.

Start the host application The application starts when the Navis™ Optical PM - NP application
is initialized to run level 4. See “run level 4” (2-5) for additional
details.

Contents
Start the Navis™ Optical PM - NP application on a
single server

3-5

Start the Navis™ Optical PM - NP application on a
Windows terminal server

3-7
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Start the Navis™ Optical PM - NP application on a single server
....................................................................................................................................................................................................................................

Purpose This procedure is used to start the Navis™ Optical PM - NP
application on a single server.

Before you begin Verify that:

• The single server has been powered up; see “Power on an HP
server in a single server configuration” (2-14).

• The GUI has been downloaded on the desktop(s) or terminal
server(s).

Task Use these steps to start the Navis™ Optical PM - NP application
on a single server.
............................................................................................................................................................

1 Log into the server as root.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

Current run level information, such as run-level 3 Oct 30

11:26 3 0 S, is displayed.

..........................................................................................................................................................

3 Continue with one of the following options.

IF THEN

run-level is 3, proceed to the next step to continue.

run-level is 4, the application is already running; no
further action is necessary.

run-level is not 3 or 4, contact the system support staff. (See
the Technical support information
located at the beginning of this
document for details.)

............................................................................................................................................................

4 At the prompt, enter init 4.
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Result:

The run level is changed to run-level 4.

............................................................................................................................................................

5 At the prompt, enter tail —f/etc/rc.log

Important! To terminate this command, press the Ctrl and c
buttons.

Result:

The following message is displayed:

WS-NMS Application has been started...

HP-UX run-level transition completed

<Weekday> MMM DD HH:MM:SS <timezone> YYYY
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Start the Navis™ Optical PM - NP application on a Windows
terminal server
....................................................................................................................................................................................................................................

Overview Once the Windows terminal server is powered on (see “Power on a
Windows terminal server” (2-15)), it is not necessary to start the
Navis™ Optical PM - NP application on a Windows terminal server;
therefore a procedure is not required.
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Section II: Start the Navis™ Optical PM - NP Application on the
User Interface

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to start Navis™ Optical PM - NP
application on the user interface (UI).

Background Once the servers are powered up (as described in the previous section
of this chapter), users can start the Navis™ Optical PM - NP
application:

• on an HP-UX workstation

• on a Windows PC

This section includes information on how to start Navis™ Optical PM
- NP application on HP-UX workstation and on a Windows PC in a
single-server configuration only.
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3-10

Start the Navis™ Optical PM - NP application on a
Windows PC
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Start the Navis™ Optical PM - NP application on a Windows
terminal server
....................................................................................................................................................................................................................................

Overview Once the Windows terminal server is powered on (see “Power on a
Windows terminal server” (2-15)), it is not necessary to start the
Navis™ Optical PM - NP application on a Windows terminal server,
therefore a procedure is not required.
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Start the Navis™ Optical PM - NP application on an HP-UX
workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to start the Navis™ Optical PM - NP
application on an HP-UX workstation.

Before you begin Before you begin, be sure that the HP-UX workstation is powered on.
See “Power on an HP-UX workstation” (2-22).

Task Use these steps to start the Navis™ Optical PM - NP application
on an HP-UX workstation.
............................................................................................................................................................

1 Log in to the HP-UX workstation.

Result:

The Lucent logo is displayed.

..........................................................................................................................................................

2 Continue with either of the following.

IF... THEN...

the Lucent logo is
displayed on the Common
Desktop Environment
(CDE) panel:

double-click the icon.

Result: The Navis™ Optical PM -
NP Network Map is displayed.

the icon does not appear: contact the system support staff. (See
the Technical support information
located at the beginning of this
document for details.)
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Start the Navis™ Optical PM - NP application on a Windows PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to start the Navis™ Optical PM - NP
application on a Windows PC.

Before you begin Before running the Navis™ Optical PM - NP application on a
Windows PC, the PC must be powered on (see “Power on a Windows
PC” (2-23)) and the Navis™ Optical PM - NP application must be
loaded on the PC. This task assumes that the application has been
already loaded on the PC.

Task Use these steps to start the Navis™ Optical PM - NP application
on a Windows PC.
............................................................................................................................................................

1 Log into the Windows PC.

Result:

The Windows PC icon is displayed.

..........................................................................................................................................................

2 Continue with one of the following.

IF... THEN...

the icon is displayed on the
desktop:

double-click the icon.

Result: The Navis™ Optical PM -
NP Network Map is displayed.

the icon does not display
on the desktop:

contact the system support staff. (See
the Technical support information
located at the beginning of this
document for details.)
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Section III: Stop the Navis™ Optical PM - NP Application on
the User Interface and Single Server Configurations

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to stop the Navis™ Optical PM - NP
application on HP single server configurations and the UI (user
interface).

Stop the host application The host application stops when the Navis™ Optical PM - NP
application is brought to run level 3 (multi-user mode).

Under certain circumstances, it might be necessary to bring the
Navis™ Optical PM - NP application to run level 3, for example, if the
system needs a new software load. See “run level 3” (2-5) for
additional details.
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Stop the Navis™ Optical PM - NP application on the User
Interface
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Navis™ Optical PM - NP
application on HP-UX workstations or Windows PCs.

Task Use these steps to stop the Navis™ Optical PM - NP application
on HP-UX workstations or Windows PCs.
............................................................................................................................................................

1 On the Network Map, do one of the following:

• Select File > Exit.

• Select the close button in the top right corner of the Network
Map.

Result:

A confirmation dialog box is displayed.

............................................................................................................................................................

2 At the dialog box, select OK.

Result:

The Navis™ Optical PM - NP session is terminated.
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Stop the Navis™ Optical PM - NP application on a single server
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Navis™ Optical PM - NP
application on a single server.

Task Use these steps to stop the Navis™ Optical PM - NP application
on a single server.
............................................................................................................................................................

1 Log into the server as root.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

Current run level information, such as run-level 4 Oct 30

11:26 3 0 S is displayed.

..........................................................................................................................................................

3 Continue with one of the following options.

IF THEN

run-level is 4, proceed to the next step to continue.

run-level is 3, the application is not running; no
further action is necessary.

run-level is not 3 or 4, contact the system support staff. (See
the Technical support information
located at the beginning of this
document for details.)

............................................................................................................................................................

4 At the prompt, enter init 3.

Result:

The run level is changed to run-level 3.

............................................................................................................................................................

5 At the prompt, enter tail —f/etc/rc.log

Important! To terminate this command, press the Ctrl and c
buttons.
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Result:

The following message is displayed:

HP-UX run-level transition completed

<Weekday> MMM DD HH:MM:SS <timezone> YYYY
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Stop the Navis™ Optical PM - NP application on a Windows
terminal server
....................................................................................................................................................................................................................................

Overview Since the Navis™ Optical PM - NP application is not run on a
Windows terminal server, a procedure is not required.
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Stop the Navis™ Optical PM - NP application on a server
configuration with a UPS
....................................................................................................................................................................................................................................

Introduction An Uninterruptible Power Supply (UPS) is used to protect the main
servers and their essential peripherals from a power failure. The UPS
enables the system to shut down gracefully within the time limit
specified in a configurable timer parameter.

A UPS is only compatible with Non-Safeguard configurations.
Systems configured with a UPS are brought into init 4 automatically
upon power up.

Configurable file The UPS provides a configurable file that contains two timer
parameters that are used in the shutdown process. When the Navis™

Optical PM - NP application receives notification of a loss of AC
power, the application runs a shutdown script that gracefully shuts
down the application within the time limit of these timer parameters:

• shutdown_delay_mins indicates the number of minutes following
notification that its UPS has switched to internal battery power
before the UPS monitor initiates a shutdown. The default value
for this parameter is one minute.

• shutdown_timeout_mins indicates the number of minutes to
monitor the shutdown operation before a reboot is initiated with
the halt option. The default value for this parameter is five
minutes.

These timer parameters are only tunable at installation time; they
cannot be changed subsequent to installation. (During typical
operating conditions, these parameters should not have to be changed.)
.
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Section IV: Restart and Stop the Oracle Database

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to restart and stop the Oracle database.

Definition: Oracle database The Oracle database is used to retain persistent copies of application
and customer data. Use of Oracle’s Transaction Processing Option
enables concurrency control and data integrity.

Important Starting and stopping the database should be performed only at the
direction of Lucent Customer Support.
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Restart the Oracle database
....................................................................................................................................................................................................................................

Purpose This procedure is used to restart the Oracle database.

Important! This procedure is only performed at the direction of
Lucent Customer Support.

Task Use these steps to restart the Oracle database.
............................................................................................................................................................

1 Using the system console, log in as oracle.

............................................................................................................................................................

2 Enter /usr/dacscan/toolbin/startdb.sh at the prompt.

Result:

A displayed message indicates that the database has been started.
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Stop the Oracle database
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Oracle database. (For example, the
Oracle database would have to be stopped before it is backed up. )

Important! This procedure is only performed at the direction of
Lucent Customer Support.

Task Use these steps to stop the Oracle database:
............................................................................................................................................................

1 Using the system console, log in as oracle.

............................................................................................................................................................

2 Stop the application on the primary server.

Reference:

For instructions, see the section “Stop the Navis™ Optical PM -
NP application on the User Interface” (3-13).

............................................................................................................................................................

3 Enter /usr/dacscan/toolbin/shutdb.sh at the prompt.

Result:

A displayed message indicates that the database has been
stopped.
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Section V: Administer the System cron File

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the system cron file.

Background The cron file contains commands that are automatically executed at
set times.

Certain commands can be executed at particular times by using the
system cron. The root cron and dacscan cron operate independently.
The root cron has various administrative functions that are executed
on a routine basis, such as daily backups and file system space
monitoring. The dacscan cron has various application-related
functions, such as database syncs and auto-implementation.

File format The read-only root cron file format is such that everything on the
active line is separated by blanks or tabs. Each field of the active line
correlates to a subset of time. The following is an example of an
active line, with each field separated by a tab (indicated by -->):

min-->hour-->day-->month-->day-of-week-->command min: 0-59
hour: 0-23 day:1-31 month:1-12 day of week: 0-6 (Sunday=0)
command: program to be executed

In place of numerics, an asterisk (*) can be used to imply the whole
range (wild card). A sample active line may look like:

01 04,23 * * * ksh /usr/dacscan/bin/auto_backup &

This line implies that the auto_backup will execute in the background
one minute past the fourth hour (4:01 a.m.) and, again, one minute
past the twentieth third hour (11:01 p.m.), every day, every month,
and every day of the week.

The cron files can be edited however, editing should be performed
only at the direction of Lucent Customer Support. Once the file is
created/edited, it must be loaded into the cron.
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Edit the system cron file 3-25
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View the dacscan cron file
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the dacscan cron file.

Important! The dacscan cron file is a read-only file, which only
the superuser (root) can edit.

Task Use these steps to view the dacscan cron file.
............................................................................................................................................................

1 Using the system console, log into the primary server as dacscan.

Important! Using the root login, you can alternatively enter su
- dacscan and enter the dacscan password.

............................................................................................................................................................

2 Enter crontab -l at the # prompt.

............................................................................................................................................................

3 Press Enter.

Result:

The dacscan cron file is displayed.
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View the root cron file
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the root cron file.

Important! The root cron file is a read-only file, which only the
superuser (root) can edit.

Task Use these steps to view the root cron file.
............................................................................................................................................................

1 Using the system console, log into the primary server as root.

............................................................................................................................................................

2 Enter crontab -l at the # prompt.

............................................................................................................................................................

3 Press Enter.

Result:

The root cron file is displayed.
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Edit the system cron file
....................................................................................................................................................................................................................................

Purpose This procedure is used to change the desired execution times of
commands in the system cron file.

Important! Only the superuser (root) can edit the system cron
file.

Task Use these steps to edit the system cron file.
............................................................................................................................................................

1 Using the system console, log into the primary server as root.

............................................................................................................................................................

2 At the # prompt, type cd /usr/spool/cron/crontabs

............................................................................................................................................................

3 At the # prompt, type ls -l

Result:

The files root and dacscan are listed.

............................................................................................................................................................

4 Open the root or dacscan file using the vi editor and then edit the
desired parameter.

............................................................................................................................................................

5 Press Esc, and then type :wq to save and close the file.

..........................................................................................................................................................

6 Use one of the following to read the revised file into the system cron.

IF... THEN...

the root file was edited: log in as root and then type: crontab
root at the # prompt.

Result: The root file is read into the
system cron.

the dacscan file was
edited:

log in as dacscan and then type
crontab dacscan at the # prompt.

Result: The dacscan file is read
into the system cron.
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Section VI: Monitor Space

Overview
....................................................................................................................................................................................................................................

Purpose The Navis™ Optical PM - NP application has an internal, space
monitoring script that periodically checks its own file systems to
verify that they are not running out of space. The following section
describes the Navis™ Optical PM - NP script that generates warning
and recovery messages as required.

System Administration
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Spacewatch
....................................................................................................................................................................................................................................

Purpose Spacewatch is a space monitoring and recovery program that provides
file-system monitoring once per hour for the following controller files:

• provisioning documents directory (/dacscan/prov)

• alarms directory (/dacscan/alarms)

• application logs directory (/dacscan/log)

• database archives directory (/dacscan/dbarch)

• application users directory (/dacscan/users)

• application trace information directory (/dacscan/trace)

Warning messages If a controller file is over 60% full, Spacewatch sends this warning
message to the system event log: ªLog fileº running low on

space - clean up immediately!

Recovery
actions/messages

Special recovery actions/messages are provided for the following files:

• If /dacscan/trace is over 80% full, its recovery action is:
Removed log files - Archives may be incomplete!

• If dacscan/log is over 80% full, its recovery action is: Removed

log files - Archives may be incomplete!

• If dacscan/users is over 80% full, its recovery action is:
″Logfile″ is running low on space, clean up

immediately!

• The dacscan/dbarch controller file recovery message is:
″Logfile″ removed database archive file - back up

database immediately!
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Section VII: Administer Performance Monitoring Data Export

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the Performance Monitoring
Data Export feature via off-line tools.

Performance Monitoring Data Export is an optional feature that
enables the automatic capture of all 24-hour performance monitoring
data for all network elements controlled by the Navis™ Optical PM -
NP application. During execution, it requests that all 24-hour
performance monitoring data collected for the previous day be
transferred to an ASCII file—one per Element Management System
(EMS)—on a workstation or PC specified at the time of installation.

Contents
Performance Monitoring Data Export Variables 3-29

Display Performance Monitoring Data Export
variable settings

3-30

Change the scheduled run time of the Performance
Monitoring Data Export file transfer

3-31

Workstation set up for data export task 3-32

Execute the Performance Monitoring Data Export
tool

3-34
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Performance Monitoring Data Export Variables
....................................................................................................................................................................................................................................

Overview The Performance Monitoring Data Export feature executes according
to the values specified by certain environment variables that control
how this feature operates:

• $PM_LOG_WKST is a variable that exists on the server. It is the
workstation to which performance monitoring data is exported.

• $PM_LOG_DIR is a variable that exists on the server. It is the
directory on the $PM_LOG_WKST workstation where the
exported data is stored. In this directory, the user must create one
subdirectory for each day of the week, plus yesterday: Monday,
Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday, and
yesterday.

• $PM_DATA_FILE is variable file on the $PM_LOG_WKST
workstation that contains the exported performance monitoring
data.

• $PM_DATA_FILE_DIR is the directory on the server that
contains the request files. One request file must be created for
each EMS, based on the $PM_DATA_FILE environment
variable and the EMS name.

• $PM_EMS_TIMEOUT is the duration (in seconds) that is
allocated to the EMS to collect and export the requested data.
When this duration expires, a time-out error is logged.

For example, given these environment variables, the most recently
transferred performance monitoring data file is located at:

$PM_LOG_WKST:$PM_LOG_DIR/<yesterday>/$PM_DATA_FILE

The $PM_LOG_WKST and the $PM_LOG_DIR variables are located
on the server in the /etc/dscan directory. Their values are set at
installation. The remaining variables, ($PM_DATA_FILE ,
$PM_DATA_FILE_DIR and $PM_DATA_TIMEOUT ) are set up
when the export tool is run.
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Display Performance Monitoring Data Export variable settings
....................................................................................................................................................................................................................................

Purpose This procedure is used to display Performance Monitoring Data
Export variable settings.

Task Use these steps to display Performance Monitoring Data Export
variable settings.
............................................................................................................................................................

1 From a workstation, log in as dacscan.

............................................................................................................................................................

2 To display Performance Monitoring Data Export variable settings,
enter one of the following at the prompt.

• To display all variable settings, type env

• To display a specific variable’s setting, type echo
<$variable_name>

Result:

The variable settings are displayed.

Section VII: Administer Performance
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Change the scheduled run time of the Performance Monitoring
Data Export file transfer
....................................................................................................................................................................................................................................

Purpose This procedure is used to change the scheduled run time of the
Performance Monitoring Data Export file transfer.

The Performance Monitoring Data Export file transfer process is
scheduled to run daily. By default, it is scheduled to run at 02:10 a.m.
local time.

Important! This task should be performed only at the direction
of Lucent Customer Support.

Task Use these steps to change the scheduled run time of the
Performance Monitoring Data Export file transfer process.
............................................................................................................................................................

1 Log into the host as dacscan.

............................................................................................................................................................

2 Enter crontab -e

............................................................................................................................................................

3 Locate the following line in the file, which is used to clean up the old
files and start the PM log file process:

mm hh * * * ksh /usr/dacscan/toolbin/StartPmData.sh >

/tmp/StartPmData.log

............................................................................................................................................................

4 Edit the mm and hh entries so they correspond with the required hour
(hh) and minute (mm).

............................................................................................................................................................

5 Enter <shift:wq!>

Result:

The scheduled run time of the performance monitoring data file
transfer process is changed.
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Workstation set up for data export task
....................................................................................................................................................................................................................................

Purpose This procedure is used to set up the workstation for PM data export to
monitor reports.

Before you begin Ensure that a dacscan login ID does not already exist on the
workstation.

You must access the .rhosts file, which is typically found in
/usr/dacscan/.rhosts. (Under most conditions, the .rhosts file does
not have to be created or re-created.)

In step 5, you must create a directory structure that can be used to
store data for each day of the week along with one subdirectory as a
backup yesterday directory. The access privileges for these directories
must be changed so their contents can be read by and written to by
the owner, group, and other.

Example:

cd /usr/dacscan

mkdir pm_export (This directory name is user specified; any
directory name can be assigned to the directory; however, the same
directory name must exist on the server.)

chmod 777 pm_export (Change the permissions on the directory just
created so it is accessible to all.)

cd pm_export (Change directories to the directory that you just
created.)

mkdir Monday (Make a subdirectory under pm_export called
Monday.)

chmod 777 Monday (Change the permissions of the directory
Monday so it is accessible to all.)

mkdir Tuesday (Make another subdirectory under pm_export called
Tuesday.)

chmod 777 Tuesday (Change the permissions of the directory
Tuesday so it is accessible to all.)

Continue to make directories for each remaining day of the week,
along with a directory called yesterday, and change the access
privileges for each directory created.
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Task Use these steps to create a dacscan login ID and to modify the
.rhosts file.
............................................................................................................................................................

1 Create a dacscan login ID. See “Section VII: Administering Users”
(2-37).

............................................................................................................................................................

2 From a new terminal window on that workstation, log in as the
dacscan user.

............................................................................................................................................................

3 Enter cd $HOME.

............................................................................................................................................................

4 Using vi, access the .rhosts files and add a line to the file with the
name of the host machine where PF and performance monitoring
servers are running for the Navis™ Optical PM - NP application.

............................................................................................................................................................

5 On the workstation, set up a directory structure for storing PM data.
(See Before you begin.)

............................................................................................................................................................

6 Log into the Navis™ Optical PM - NP host machine as dacscan.

............................................................................................................................................................

7 Enter remsh <name of Workstation> uname -a to test whether the
.rhosts file works correctly.

Result:

The name and operating system of the workstation are
displayed.
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Execute the Performance Monitoring Data Export tool
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the relevant log information, view the
current environment associated with the Performance Monitoring Data
Export tool, or to reissue the request to transfer the 24-hour
performance monitoring data associated with the previous day.

Related Information The Performance Monitoring Data Export tool allows a host user to
view relevant log information and to view the current environment
associated with this feature. It provides the means for a host user to
reissue the request to transfer 24-hour performance monitoring data
associated with the previous day

Any user can access the Performance Monitoring Data Export tool
from the host server. It is located in /usr/dacscan/toolbin.

Task Use these steps to execute the Performance Monitoring Data
Export.
............................................................................................................................................................

1 From the system prompt, enter: /usr/dacscan/toolbin/pm_export_
tool

Result:

A user menu is displayed.

..........................................................................................................................................................

2 IF THEN

You want to display the
Performance Monitoring
Data Export feature
overview

Enter 1

You want to display the
Performance Monitoring
Data Export feature
environment

Enter 2

You want to view the
Performance Monitoring
Data Export log entries for
mm/dd/yyyy

Enter 3
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IF THEN

You want to reissue the
request to export 24-hour
performance monitoring
data

(An option does not exist
to issue a request on an
individual EMS basis.)

Enter 4

You want to quit executing
the Performance
Monitoring Data Export
tool.

Enter 5

Result: Relevant log files are
created and are located in
/usr/dacscan/toolbin.

On a dedicated UNIX workstation,
uncompress the Performance
Monitoring Data Export files by
entering the command gunzip -c
<filename>

Section VII: Administer Performance
Monitoring Data Export
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Section VIII: Network Map

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks associated with the Network Map,
including tasks associated with network elements, changing the
background map, and changing model names.

Contents
Install a new background map 3-37

Update network element positions 3-38

Search for the Location Reference Table 3-39

Modify noncontrolled network element information 3-41

Change the model name of a network element 3-43
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Install a new background map
....................................................................................................................................................................................................................................

Purpose This procedure requires the use of an off-line tool to install a new
background map on HP-UX client machines or on Windows terminal
servers.

The system administrator of the host will use off-line hardware, such
as a scanner, to scan the customer’s map and save it on the host
machine as a .gif file. This map may be an image (.gif) file scanned
by the user and stored in the host machine’s
$DEST/jnm/itm/data/customer directory.

To perform this task, contact Lucent Customer Support.

Choosing a background
map

A new background map must be selected carefully, so it does not
obscure the icons and its displayed text. For example, a map that is
largely white hides the white text of the icon names.

When selecting a background map, keep the following in mind:

• Select a map that is mainly a different color than the icons and
text displayed on the map.

• Select a map that includes colors that contrast sufficiently with
the icons and text displayed on the map that they are easily
distinguished by the user.

Task Use this step to install a new background map for all users.
............................................................................................................................................................

1 Contact Lucent Customer Support to perform this task.
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Update network element positions
....................................................................................................................................................................................................................................

Purpose This procedure is used to update network element positions on the
Network Map.

Before you begin You must have configuration management, element management, or
system administrator privileges to save the updated network element
positions on the Network Map. See “ System administrator user
types” (1-3) for a description of what is allowed for system
administrators.

Task Use these steps to move a node to a new position permanently on
the Network Map.
............................................................................................................................................................

1 On the Network Map, select the node to be repositioned.

............................................................................................................................................................

2 Drag and drop the node to the new location.

Result:

The node and its connecting links are repositioned.

............................................................................................................................................................

3 Select the following menu option: File > Save Node and Label Map
Positions.

Result:

The network element location is updated.
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Search for the Location Reference Table
....................................................................................................................................................................................................................................

Purpose This procedure is used to search for location-type information for a
specific network element. The user may query by Office/Location/NE
ID, Area, or Node Type, or request a list of all location-type
information.

Network element queries display controlled or noncontrolled network
elements. Controlled network elements are those controlled or
cataloged by the Navis™ Optical PM - NP application. Noncontrolled
network elements include black boxes.

Results received from controlled network element queries include
information about the digital cross-connect systems that are part of the
network.

Important! The search is limited to NEs that are controlled or
cataloged by the Navis™ Optical PM - NP application.

Task Use these steps to search for location-type information for a
specific network element.
............................................................................................................................................................

1 On the Network Map, select Administration.

............................................................................................................................................................

2 Select Location Reference Table.

Result:

The Location Reference Table Query Box is displayed.

..........................................................................................................................................................

3 IF THEN

You want to query by
office location or network
element ID,

Enter the office location or network
element ID in the Office Location/NE
ID field.

You want to query by area
ID,

Select a value from the Area
drop-down list.

You want to query by node
type,

Select a value from the Node Type
drop-down list.
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IF THEN

You want to query all
available location-type
information,

Leave all fields blank, then proceed to
the last step.

............................................................................................................................................................

4 Optional: Complete the Additional Information field.

............................................................................................................................................................

5 Select OK.

Result:

The Location Reference Table displays the requested
location-type information.

When the value ITMNM displays in the Type field, this represents the
Navis™ Optical PM - NP. When SNMS displays in the Type field, this
represents the Navis™ Optical EMS.

Section VIII: Network Map
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Modify noncontrolled network element information
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify the description or administration
information of an existing noncontrollable network element, including
black boxes.

Task Use these steps to modify the description or administrative
information of a noncontrollable network element.
............................................................................................................................................................

1 From the Network Map, select Administration > Location Reference
Table.

Result:

The Location Reference Table Query Box is displayed.

............................................................................................................................................................

2 In the Office Location/NE ID field, select the appropriate existing
noncontrollable NEs.

............................................................................................................................................................

3 Optional: Enter a 1 to 33 character string in the Additional
Information field.

............................................................................................................................................................

4 Optional: Select the Area associated with the noncontrolled network
element from the drop-down menu.

............................................................................................................................................................

5 Optional: Select the Node Type associated with the noncontrolled
network element from the drop-down menu.

............................................................................................................................................................

6 Click OK.

Result:

The Location Reference Table is displayed.

When the value ITMNM displays in the Type field, this represents the
Navis™ Optical PM - NP. When SNMS displays in the Type field, this
represents the Navis™ Optical EMS.
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............................................................................................................................................................

7 To modify the information, either click the first box in a row to select
the row or click a box in a specific column to modify the information.
You can modify rows in the following columns:

• Description

• Acronym

• Additional Information

............................................................................................................................................................

8 Select Actions > Update.

............................................................................................................................................................

9 Select File > Close.

Result:

The description or administration information of the network
element is modified.
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Change the model name of a network element
....................................................................................................................................................................................................................................

Purpose This procedure is used to change a model name.

Before you begin When changing the model name of network element, do not use the
forward slash character, which is /, when renaming the network
element.

Task Use these steps to change a model name.
............................................................................................................................................................

1 Delete the network element that has a model name to be changed. See
the Navis™ Optical PM - NP Provisioning Guide for instructions.

Result:

The network element is deleted.

............................................................................................................................................................

2 Add the network element and enter the new model name. See the
Navis™ Optical PM - NP System Provisioning Guide for details.

Important! The network elements that Navis™ Optical EMS
supports do not have to be re-added because they are
automatically discovered by the Navis™ Optical PM - NP
application.

Result:

The network element is added and contains a new model name.
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Section IX: Administer the TIM Northbound Alarm Interface

Overview
....................................................................................................................................................................................................................................

Purpose This section explains how to set filtering criteria for the Navis™

Optical PM - NP alarms to be sent to the TNM Integration Module
(TIM) northbound alarm interface. The TIM Northbound Alarm
Interface is an option.

Contents
Set filtering criteria for Navis™ Optical PM - NP
alarms

3-45
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Set filtering criteria for Navis™ Optical PM - NP alarms
....................................................................................................................................................................................................................................

Purpose This optional procedure is used to set filtering criteria for Navis™

Optical PM - NP alarms to be sent to the TIM northbound alarm
interface.

Task Use these steps to set filtering criteria for Navis™ Optical PM -
NP alarms.
............................................................................................................................................................

1 Start the Navis™ Optical PM - NP application.

Reference:

For instructions, see the section “Start the Navis™ Optical PM -
NP application on an HP-UX workstation” (3-10).

............................................................................................................................................................

2 On the Network Map, select Administration > NB Transmission
Filter

Result:

The Alarm Transmission Filter form is displayed.

............................................................................................................................................................

3 To send the Navis™ Optical PM - NP application’s service-affecting
and non-service affecting alarms to the TIM northbound alarm
interface, select Both then click OK. To send the Navis™ Optical PM
- NP application’s service-affecting alarms only to the TIM
northbound alarm interface, select SA then click OK.

Result:

The appropriate alarms are set to sent to the TIM northbound
alarm interface.
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Section X: Set Preferences

Overview
....................................................................................................................................................................................................................................

Purpose This section defines how to set preferences for the Navis™ Optical PM
- NP application.

Contents
Set event indications preferences 3-47

Set map preferences 3-48

Set alarm preferences 3-49

Set FM operational preferences 3-50
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Set event indications preferences
....................................................................................................................................................................................................................................

Purpose This procedure is used to set event indications preferences for the
Network Event Summary.

Task Use these steps to set event indications preferences.
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Event Indications tab.

Result:

The Event Indications form, which is the default screen, is
displayed.

..........................................................................................................................................................

3 IF THEN

You want to set an audible
beep when a new alarm is
reported.

Select Set Beep On, then select the
number of beeps, from 1 to
continuous, to sound when a new
alarm is reported.

You want to set the Event
screen to display in the
foreground.

Select Set Event Screen to Foreground.

............................................................................................................................................................

4 Select OK.

Result:

The form closes. Changes to the event indications take effect
during the following and subsequent sessions.
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Set map preferences
....................................................................................................................................................................................................................................

Purpose This procedure is used to set map preferences.

Task Use these steps to set map preferences.
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Map tab.

Result:

The Map form displays the User Login View and Link Width
sections.

..........................................................................................................................................................

3 IF THEN

You want to select a
different map view,

In the User Login View Section’s Map
View Field, highlight an entry in the
drop down list.

Important! The System Area Map is
the default.

You want to specify area or
select no area,

In the User Login View Section’s
Expand Area field, highlight an entry
in the second tab’s drop down list.

You want to change the
Network Map’s link width
display,

In the Link Width section of the form,
select Normal to have links display at
a normal width or Heavy to have links
display at a wide width.

............................................................................................................................................................

4 Select OK.

Result:

The form closes. Changes to the map will take effect during the
next and subsequent sessions.
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Set alarm preferences
....................................................................................................................................................................................................................................

Purpose This procedure is used to set alarm preferences on forms.

Task Use these steps to set alarm preferences on forms.
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Alarm Information On Forms tab.

Result:

The Alarm Information on Forms form is displayed.

............................................................................................................................................................

3 Click each box corresponding to the form to be changed.

Result:

Each selected box is marked.

............................................................................................................................................................

4 Select OK.

Result:

The form closes.

............................................................................................................................................................

5 Close the Navis™ Optical PM - NP application then bring it back up.

Result:

Changes to the alarm preferences will take effect during the next
and subsequent sessions.

Section X: Set Preferences System Administration
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Set FM operational preferences
....................................................................................................................................................................................................................................

Purpose This procedure is used to set fault management (FM) operational
preferences.

Task Use these steps to set FM operational preferences.
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the FM Operational Mode tab.

Result:

The Fault Management Operational Mode form is displayed.

..........................................................................................................................................................

3 IF THEN

You want to set fault
management to use the
alarm approach,

Select Alarm Approach.

You want to set fault
management to use the
service approach,

Select Service Approach.

............................................................................................................................................................

4 Select OK.

Result:

An Attention dialog box is displayed indicating that the change
will take effect for the next and subsequent sessions.

............................................................................................................................................................

5 On the Attention dialog box. select OK.

Result:

The dialog box closes.

............................................................................................................................................................

6 On the Fault Management Operational Mode form, select OK.

Section X: Set Preferences System Administration
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Result:

The Fault Management Operational Mode form closes.

Section X: Set Preferences
Set FM operational preferences
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4 User Administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains the procedures needed to administer user IDs
and user profiles in the Navis™ Optical PM - NP application.
Administrators are responsible for adding, modifying, and deleting
Navis™ Optical PM - NP user IDs and for specifying the tasks to
which a user can or cannot gain access to by assigning a user profile
to a user ID.

Contents
User Administration Concepts 4-2

Add a user 4-4

Modify a user 4-6

Delete a user 4-8

Add a user profile 4-9

Modify a user profile 4-11

Delete a user profile 4-13
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User Administration Concepts
....................................................................................................................................................................................................................................

The default administrator The Navis™ Optical PM - NP System is shipped with a default
administrator login that is called sa. This login is used by the initial
user to do initial start-up tasks. This user has access to all Navis™

Optical PM - NP System screens, including those screens that are
needed to add additional new users.

Users who are created by sa are typically set up with access to only a
subset of Navis™ Optical PM - NP System screens. Therefore, in order
to become authorized, a user has to already have the correct
permissions to access these Navis™ Optical PM - NP System screens
or to have the sa change his or her permissions.

User types and user
profile

The Navis™ Optical PM - NP application allows authorized users to
have different levels of access, which are controlled by a login ID, a
password, a user type, and a user profile.

The Navis™ Optical PM - NP User is the user who has access to the
Navis™ Optical PM - NP application. By default, this user is of the
type that is called regular user.

A user profile controls which of the task groupings a user is allowed
to perform. A user can be assigned to more than one user profile.

These task groupings can be assigned to a user profile:

• Fault Management

• Configuration Management

• Performance Monitoring

• NE Management

• System Administration

• Fault Management (View Only)

• Configuration Management (View Only)

• Performance Monitoring (View Only)

User Administration
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The Navis™ Optical PM - NP System has the following user profiles:

• The Initial profile provides access to the Fault Management,
Configuration Management, Performance Monitoring, and NE
Management task groupings. By default, all new users are
assigned to the Initial Profile.

• The Combined profile provides access to the All Tasks task
grouping.

• The Provisioning (View Only) profile provides access to the
Configuration Management (View Only) task grouping.

• The Alarm Management profile provides access to the Fault
Management task grouping.

While each profile has a finite number of assigned tasks, the system
administrator can select which tasks to associate with the specific
profile.

In addition to the user profiles listed, the system administrator can add
a new profile, or modify or delete an existing profile. The Initial
Profile can never be deleted and the Combined Default Profile cannot
be modified or deleted.

User Administration Concepts User Administration
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Add a user
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user to the Navis™ Optical PM - NP
application.

Permissions You must be authorized to perform this task.

Before you begin The user ID must first be created in the sam program. See “Create a
User ID through SAM’s GUI-based program” (2-38) and “Create a
User ID through SAM’s terminal-based program” (2-42) for details.

Task Use these steps to add a user to the Navis™ Optical PM - NP
application:
............................................................................................................................................................

1 Start the Navis™ Optical PM - NP application. See “Section I: Start
the Navis™ Optical PM - NP Application on the HP Servers” (3-4) for
details.

Result:

The Network Map is displayed.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Add.

Result:

The Add User form is displayed.

............................................................................................................................................................

3 In the User ID field, enter a 1 to 8 character user ID.

............................................................................................................................................................

4 Optional: In the Description field, enter a 1 to 32 character
description to be associated with the user ID.

............................................................................................................................................................

5 In the Profile field, select a user profile from the drop-down list.

If a user profile is not selected, the user is automatically assigned
Initial Profile.

User Administration
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Result:

The selected profile is displayed and the tasks associated with
the profile selection are displayed in the Assigned Tasks area
of the window.

............................................................................................................................................................

6 In the User Type field, select Regular User.

............................................................................................................................................................

7 Click Apply.

Result:

A message is displayed at the bottom of the Add User form
indicating that the user is added.

............................................................................................................................................................

8 Click Close.

Result:

The Add User form closes.

............................................................................................................................................................

9 From the List of Users form, select File > Close.

Result:

The List of Users form closes.

Add a user User Administration
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Modify a user
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify user ID information.

Permissions You must be authorized to perform this task.

Task Use these steps to modify user ID information:
............................................................................................................................................................

1 Start the Navis™ Optical PM - NP application. See “Section I: Start
the Navis™ Optical PM - NP Application on the HP Servers” (3-4) for
details.

Result:

The Network Map is displayed.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form is displayed.

............................................................................................................................................................

3 Highlight the user ID to be modified.

............................................................................................................................................................

4 From the Actions menu, select Modify User.

Result:

The Modify User form is displayed.

............................................................................................................................................................

5 Change the Description, Profile, or User Type parameters as
required.

............................................................................................................................................................

6 Click Apply.

Result:

A message is displayed at the bottom of the Modify User form
that states that the parameters for the selected user are modified.

User Administration
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............................................................................................................................................................

7 Click OK.

Result:

The Modify User form closes.

............................................................................................................................................................

8 From the List of Users form, select File > Close.

Result:

The List of Users form closes.

Modify a user User Administration
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Delete a user
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user ID.

Permissions You must be authorized to perform this task.

Task Use these steps to delete a user ID:
............................................................................................................................................................

1 Start the Navis™ Optical PM - NP application. See “Section I: Start
the Navis™ Optical PM - NP Application on the HP Servers” (3-4) for
details.

Result:

The Network Map is displayed.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form is displayed.

............................................................................................................................................................

3 Highlight the user ID to be deleted.

............................................................................................................................................................

4 From the Actions menu, select Delete User.

Result:

A confirmation box is displayed and asks if you really want to
delete this user.

............................................................................................................................................................

5 Click Yes.

Result:

The user ID is deleted.

............................................................................................................................................................

6 Select File > Close.

Result:

The List of Users form closes.

User Administration
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Add a user profile
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user profile.

Permissions You must be authorized to perform this task.

Before you begin During this procedure, you are required to name the user profile. Have
a 1 to 30 character name ready for the user profile.

Task Use these steps to add a user profile:
............................................................................................................................................................

1 Start the Navis™ Optical PM - NP application. See “Section I: Start
the Navis™ Optical PM - NP Application on the HP Servers” (3-4) for
details.

Result:

The Network Map is displayed.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Profiles > Add.

Result:

The Add Profile form is displayed.

............................................................................................................................................................

3 In the Profile Name field, enter a 1 to 30 character name for the user
profile.

............................................................................................................................................................

4 Add tasks to the user profile by moving them from the Available
Tasks list to the Selected Tasks list.

............................................................................................................................................................

5 Click Apply.

Result:

The user profile is added and is now available for assignment to
users.

............................................................................................................................................................

6 Click Close.

User Administration

....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002

Lucent Technologies 4 - 9



Result:

The Add Profile form closes.

Add a user profile User Administration
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Modify a user profile
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify a user profile.

Permissions You must be authorized to perform this task.

Task Use these steps to modify a user profile:
............................................................................................................................................................

1 Start the Navis™ Optical PM - NP application. See “Section I: Start
the Navis™ Optical PM - NP Application on the HP Servers” (3-4) for
details.

Result:

The Network Map is displayed.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Profiles > Modify.

Result:

The Modify Profile form is displayed.

............................................................................................................................................................

3 In the Profile Name field, select the user profile to be modified from
the drop-down list.

Result:

The selected and available tasks for the user profile are
displayed.

............................................................................................................................................................

4 Do one of the following:

• Add tasks to the user profile by moving them from the Available
Tasks list to the Selected Tasks list.

• Remove tasks from the user profile by moving them from the
Selected Tasks list to the Available Tasks list.

............................................................................................................................................................

5 Click Apply.

Result:

The user profile is modified.

User Administration
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............................................................................................................................................................

6 Click Close.

Result:

The Modify Profile form closes.

Modify a user profile User Administration
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Delete a user profile
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user profile.

Permissions You must be authorized to perform this task.

Task Use these steps to delete a user profile:
............................................................................................................................................................

1 Start the Navis™ Optical PM - NP application. See “Section I: Start
the Navis™ Optical PM - NP Application on the HP Servers” (3-4) for
details.

Result:

The Network Map is displayed.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments> Profiles > Delete.

Result:

The Delete Profile form is displayed.

............................................................................................................................................................

3 In the Profile Name field, select the name of the user profile to be
deleted from the drop-down list.

............................................................................................................................................................

4 Click Apply.

Result:

A confirmation box is displayed and asks if you really want to
delete this profile.

............................................................................................................................................................

5 Click Yes.

Result:

The user profile is deleted.

............................................................................................................................................................

6 Click Close.

User Administration
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Result:

The Delete Profile form closes.

Delete a user profile User Administration
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5 Provisioning Administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains topology and provisioning tasks performed to
administer the Navis™ Optical PM - NP.

Contents
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Add a user defined submap 5-23

Display/Modify a user defined submap 5-24

Delete a user defined submap 5-25
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View a list of scheduled entities 5-27
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Section I: Aggregates

Overview
....................................................................................................................................................................................................................................

Purpose An aggregate is a collection of one or more network elements
collapsed into a single node displayed on the Network Map. An
aggregate may contain other aggregates.

This section discusses the provisioning tasks associated with
aggregates as they relate to managing the topology of the Navis™

Optical PM - NP Network Map.

Contents
Add an aggregate 5-4

Delete an aggregate 5-6

Add an aggregate member 5-7

Remove an aggregate member 5-9

Specify an aggregate’s acronym 5-11
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Add an aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to add an aggregate to the Navis™ Optical PM
- NP Network Map.

Task Use these steps to add an aggregate to the Navis™ Optical PM -
NP Network Map:
............................................................................................................................................................

1 On the Network Map, select Administration > Aggregate > Add.

Result:

The Aggregate Add form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow and select an Area ID.

............................................................................................................................................................

3 In the Aggregate ID field, enter a 1 to 20 character name for the
Aggregate ID.

............................................................................................................................................................

4 In the Acronym field, enter a 1 to 4 character name for the Aggregate
Acronym.

............................................................................................................................................................

5 From the Non-Member List, select any network element you want to
add to the aggregate.

Important! To select more than one node, press the Control key.
The number of network elements that can be selected at one time
is unlimited.

............................................................................................................................................................

6 Click the right arrow to move the network elements appearing in the
Non-Member list to the Members list.

Result:

The selected network elements appear within the Members list.

............................................................................................................................................................

7 Click Apply.

Section I: Aggregates Provisioning Administration
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Result:

A confirmation window is displayed.

............................................................................................................................................................

8 Click OK.

Result:

You are returned to the Aggregate Add form.

............................................................................................................................................................

9 Click OK.

Result:

The Aggregate is added to the Network Map. A corresponding
network element is displayed at the top left side of the Network
Map.

Section I: Aggregates
Add an aggregate
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Delete an aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete an aggregate from the Navis™ Optical
PM - NP Network Map.

Task Use these steps to delete an aggregate from the Navis™ Optical
PM - NP Network Map:
............................................................................................................................................................

1 From the Network Map, select Administration > Aggregate >
Delete.

Result:

The Aggregate Delete form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow and select an Area ID.

............................................................................................................................................................

3 Click the Aggregate ID to be deleted.

............................................................................................................................................................

4 Click Apply.

Result:

A confirmation window is displayed.

............................................................................................................................................................

5 Click OK.

Result:

The Aggregate Add form is displayed.

............................................................................................................................................................

6 Click OK.

Result:

The aggregate is deleted and is no longer displayed on the
Network Map.
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Add an aggregate member
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a member to an existing aggregate. A
member can be defined as a network element, which constitutes
aggregates.

Important! The number of members that can reside in an
aggregate is unlimited.

Task Use these steps to add a member to an existing aggregate:
............................................................................................................................................................

1 On the Network Map, select Administration > Aggregate >
Display/Modify.

Result:

The Aggregate Modify form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow and select an Area ID.

............................................................................................................................................................

3 In the Aggregate ID drop-down menu, click the down arrow and
select the aggregate to be modified.

Result:

The aggregate members are displayed in the Members column.

............................................................................................................................................................

4 In the Non-members column, click the network element to be added
to the aggregate.

Result:

The network element is highlighted.

............................................................................................................................................................

5 Click the left-pointing arrow.

Result:

The network element is moved to the Members column.

............................................................................................................................................................

6 Click Apply.
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Result:

A confirmation window is displayed.

............................................................................................................................................................

7 Click OK.

Result:

You are returned to the Aggregate Add form.

............................................................................................................................................................

8 Click Close.

Result:

The screen closes and the network element becomes a new
member of the aggregate.

Section I: Aggregates
Add an aggregate member

Provisioning Administration

....................................................................................................................................................................................................................................

5 - 8 Lucent Technologies 365-314-102R1.0
Issue 1, April 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Remove an aggregate member
....................................................................................................................................................................................................................................

Purpose This procedure is used to remove a member from an existing
aggregate. A member can be defined as a network element, which
constitutes an aggregate.

Before you begin Before removing a member from an aggregate, note the following:

• The aggregate must have at least one member.

• The last aggregate member cannot be deleted without deleting the
aggregate itself.

Task Use these steps to remove a member from an existing aggregate:
............................................................................................................................................................

1 From the Network Map, select Administration > Aggregate >
Display/Modify.

Result:

The Aggregate Modify window is displayed.

............................................................................................................................................................

2 In the Aggregate ID menu, click the aggregate to be modified.

Result:

The aggregate members are displayed in the Members column.

............................................................................................................................................................

3 In the Members column, click the network element to be deleted
from the aggregate.

Result:

The network element becomes highlighted.

............................................................................................................................................................

4 Click the right-pointing arrow.

Result:

The network element is moved to the Non-members column.

............................................................................................................................................................

5 Click Apply.
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Result:

A confirmation window is displayed.

............................................................................................................................................................

6 Click OK.

Result:

You are returned to the Aggregate Add form.

............................................................................................................................................................

7 Click Close.

Result:

The screen closes. The member is removed from the aggregate.

Section I: Aggregates
Remove an aggregate member
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Specify an aggregate’s acronym
....................................................................................................................................................................................................................................

Purpose This procedure is used to specify an aggregate’s on-screen acronym,
which is the title formed from the initial letters or parts of the
aggregate’s full name.

Task Use these steps to modify an aggregate’s on-screen acronym:
............................................................................................................................................................

1 From the Network Map, select Administration > Aggregate > Add.

Result:

The Aggregate Add window is displayed.

............................................................................................................................................................

2 In the Aggregate ID drop-down menu, select the aggregate whose
acronym you wish to specify.

Result:

The members of the aggregate are displayed in the Members
column.

............................................................................................................................................................

3 Select Acronym and press the Backspace key.

Result:

The Aggregate List form is displayed.

............................................................................................................................................................

4 Enter the new acronym.

............................................................................................................................................................

5 Click Apply.

............................................................................................................................................................

6 Click OK.

Result:

The aggregate acronym is modified. The change dynamically is
displayed on the screen.
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Section II: Areas

Overview
....................................................................................................................................................................................................................................

Purpose This section describes areas and describes the tasks related to areas.

Background Networks managed by theNavis™ Optical PM - NP application can be
subdivided into smaller, manageable networks called areas. When the
network is subdivided into areas containing a limited set of
nodes/aggregates and associated links, the potential to overcrowd the
display is reduced and the system performance is improved because
less information is exchanged by the subsystems.

Areas can be a set of nodes/aggregates:

• dedicated to a subscriber

• which are or are not connected

• in a geographic location or building

Areas cannot reside within other areas.

Users can choose to view only the areas they are interested in, which
reduces the potential to overcrowd the display and improves system
performance because less information is exchanged by the subsystems.

Only a system administrator can create areas.

Definition: area An area is a collection of nodes, aggregates, and their associated
links. An area is displayed as an icon on the Area Panel of the
Network Map. An area can be expanded, which causes the Expansion
Panel to appear on the Network Map and display all of the nodes,
aggregates, and links in the area.

The number of network elements that can be included in an area is
unlimited; however a limit of 300 network elements in an area is
recommended to avoid a cluttered display and performance problems.

Contents
Add an area 5-13

Modify an area 5-15

Delete an area 5-17
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Add an area
....................................................................................................................................................................................................................................

Purpose This procedure is used to add an area.

Permissions You must be authorized to perform this task.

Task Use these steps to add an area:
............................................................................................................................................................

1 On the Network Map, select Administration > Area > Add.

Result:

The Area Create form is displayed.

............................................................................................................................................................

2 In the Area ID field, enter a 1 to 20 character name for the Area ID.

............................................................................................................................................................

3 Select OK.

Result:

The area is added. An area icon is displayed in the top left side
of the Area Panel on the Network Map. An entry for the new
area is displayed in the Network Tree Panel on the Network
Map.
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For more information For instructions on how to add members to the area that was created
with this task, see the following task, “Modify an area” (5-15)

Section II: Areas
Add an area
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Modify an area
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify an area.

Permissions You must be authorized to perform this task.

Task Use these steps to modify an area:
............................................................................................................................................................

1 On the Network Map, select Administration > Area >
Display/Modify.

Result:

The Area Modify form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow to select the Area ID from
the drop-down list.

Result:

Non-members of the area display in the Non-Members list, and
members of the area display in the Members list.

............................................................................................................................................................

3 Do one of the following:

• Add nodes to the area by moving them from the Non-Members
list to the Members list.

• Delete nodes from the area by moving them from the Members
list to the Non-Members list.

............................................................................................................................................................

4 Select Apply.

Result:

The area is modified. The Non-Members and Members lists
reappear and display the modifications.

............................................................................................................................................................

5 Select Close.
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Result:

The Area Modify form closes.
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Delete an area
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete an area.

Permissions You must be authorized to perform this task.

Task Use these steps to delete an area:
............................................................................................................................................................

1 On the Network Map, select Administration > Area > Delete.

Result:

The Area Delete form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow to select the Area ID from
the drop-down menu.

............................................................................................................................................................

3 Select OK.

Result:

The area is deleted. The area icon is deleted from the Area
Panel on the Network Map. The entry for the area disappears
from the Network Tree Panel on the Network Map.
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Section III: User Defined Area Map

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add, display/modify, or delete user
defined area maps. These maps allow a specific user to define which
network elements to display on the screen within a submap. (See
“Section IV: User Defined Submap” (5-22).)

Contents
Add a user defined area map 5-19

Display/Modify a user defined area map 5-20

Delete a user defined area map 5-21
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Add a user defined area map
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user defined area map.

Permissions You must be authorized to perform this task.

Task Use these steps to add a user defined area map:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined Area
Map > Add.

Result:

The Add User Defined Area Map form is displayed.

............................................................................................................................................................

2 In the User Defined Area Map Name field, enter a 1 to 20 character
name for the user defined map.

............................................................................................................................................................

3 To add member(s) to the new area map, select one or more entries
from the Non-Members list, then click the left arrow button.

Important! You can optionally complete the Filters field to
lessen the number of listed entries.

Result:

The selection(s) are moved to the Members list.

............................................................................................................................................................

4 Select OK.

Result:

The new user defined area map is added and the Add User
Defined Area Map form closes.
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Display/Modify a user defined area map
....................................................................................................................................................................................................................................

Purpose This procedure is used to display/modify a user defined area map.

Permissions You must be authorized to perform this task.

Task Use these steps to display/modify a user defined area map:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined Area
Map > Display/Modify.

Result:

The Modify User Defined Area Map form is displayed.

............................................................................................................................................................

2 In the User Defined Area Map Name field, click the down arrow to
select the map to be displayed/modified.

Result:

The selected information is displayed.

............................................................................................................................................................

3 Do one of the following:

• Make no changes and proceed to the next step.

• Add member(s) to the area map by selecting one or more entries
from the Non-Members list, then click the left arrow button.

• Remove member(s) from the area map by selecting one or more
entries from the Members list, then click the right arrow button.

............................................................................................................................................................

4 Select OK.

Result:

The area map is modified if changes were made.
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Delete a user defined area map
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user-defined area map.

Permissions You must be authorized to perform this task.

Task Use these steps to delete a user defined area map:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined Area
Map > Delete.

Result:

The Delete User Defined Area Map form is displayed.

............................................................................................................................................................

2 In the User Defined Area Map Name field, click the down arrow to
select a map name from the drop-down menu.

Result:

The selected information is displayed.

............................................................................................................................................................

3 Select OK.

Result:

The user defined area map is deleted.

Section III: User Defined Area Map Provisioning Administration

....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002

Lucent Technologies 5 - 2 1

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section IV: User Defined Submap

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add, display/modify, or delete user
defined submaps that allow a specific user to define what areas to
display on the screen. (See also “Section II: Areas” (5-12) and
“Section III: User Defined Area Map” (5-18).)

Contents
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Delete a user defined submap 5-25
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Add a user defined submap
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user defined submap.

Permissions You must be authorized to perform this task.

Task Use these steps to add a user defined submap:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Add.

Result:

The Add User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, enter a 1 to 20 character
name for the user defined submap.

............................................................................................................................................................

3 To add member(s) to the new submap, select one or more entries from
the Non-Members list, then click the left arrow button.

Important! You can optionally complete the Filters field to
lessen the number of listed entries.

Result:

The selection(s) are moved to the Members list.

............................................................................................................................................................

4 Select OK.

Result:

The new user defined submap is added and the Add User
Defined Submap form closes.
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Display/Modify a user defined submap
....................................................................................................................................................................................................................................

Purpose This procedure is used to display/modify a user defined submap.

Permissions You must be authorized to perform this task.

Task Use these steps to display/modify a user defined submap:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Display/Modify.

Result:

The Modify User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, click the down arrow to
select the submap to be displayed/modified.

Result:

The selected information is displayed.

............................................................................................................................................................

3 Do one of the following:

• Make no changes and proceed to the next step.

• Add member(s) to the submap by selecting one or more entries
from the Non-Members list, then click the left arrow button.

• Remove member(s) from the submap by selecting one or more
entries from the Members list, then click the right arrow button.

............................................................................................................................................................

4 Select OK.

Result:

The submap is modified if changes were made.
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Delete a user defined submap
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user-defined submap.

Permissions You must be authorized to perform this task.

Task Use these steps to delete a user defined submap:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Delete.

Result:

The Delete User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, click the down arrow to
select a map name from the drop-down menu.

Result:

The selected information is displayed.

............................................................................................................................................................

3 Select OK.

Result:

The user defined submap is deleted.
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Section V: Scheduled Entities

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the administration of scheduled entities.

Definition: Scheduled
entity

A scheduled entity is a provisioning assignment for a facility, path, or
circuit that has been designated to occur at a future date and time. All
assignments, with the exception of digital links, can be scheduled.

Contents
View a list of scheduled entities 5-27

Delete a scheduled entity 5-28

Modify a scheduled entity 5-29

Filter the display of scheduled entities on the
Scheduled List

5-30

View successful/failed scheduled entities through
the Scheduled History List

5-32
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View a list of scheduled entities
....................................................................................................................................................................................................................................

Purpose This procedure is used to view a list of scheduled entities.

Before you begin The active form must be the Network Map.

Task Use these steps to view a list of scheduled entities:
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter the Scheduled Entity.

............................................................................................................................................................

3 Enter the Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled List form displays the queried information.
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Delete a scheduled entity
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a scheduled entity.

Task Use these steps to delete a scheduled entity:
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter an existing Scheduled Entity.

............................................................................................................................................................

3 Enter a Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled List form is displayed with the queried
information.

............................................................................................................................................................

5 Select Actions > Delete.

Result:

A confirmation box is displayed that prompts the user to
confirm the delete request.

............................................................................................................................................................

6 Select OK.

Result:

The selected scheduled entity is deleted.
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Modify a scheduled entity
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify a scheduled entity.

Task Use these steps to modify a scheduled entity:
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter an existing Scheduled Entity.

............................................................................................................................................................

3 Enter the Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled List form is displayed with the queried
information.

............................................................................................................................................................

5 Select Actions > Modify.

Result:

A popup form is displayed for the selected entity.

............................................................................................................................................................

6 Change the Start Date, Start Time, or both.

............................................................................................................................................................

7 Select OK.

Result:

The selected scheduled entity is modified.
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Filter the display of scheduled entities on the Scheduled List
....................................................................................................................................................................................................................................

Purpose This procedure is used to filter the display of the scheduled entities on
the Scheduled List.

Task Use these steps to filter the display of the scheduled entities on
the Scheduled List:
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter a Scheduled Entity.

............................................................................................................................................................

3 Select OK.

Result:

The Scheduled List form is displayed with the queried
information.

............................................................................................................................................................

4 Select the Scheduled Entity.

............................................................................................................................................................

5 Select View > Filter/Sort.

Result:

The Scheduled List Sort/Filter form is displayed.

............................................................................................................................................................

6 Select the Filter tab.

Result:

The Filter fields are displayed.

............................................................................................................................................................

7 In the Filter 1, Filter 2, and Filter 3 fields, select a field from the
drop-down menu, then enter a value to the right of your selection.
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............................................................................................................................................................

WARNING
When the Date or Time fields are selected, enter the From
and To date values in the appropriate fields.

8 Select OK.

Result:

The filtered entities are displayed on the Scheduled List form.
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View successful/failed scheduled entities through the Scheduled
History List
....................................................................................................................................................................................................................................

Purpose This procedure is used to query the system for a historical list of
scheduled entities that were successfully completed or that failed
during reinstatement.

Task Use these steps to query the system for a historical list of
successful/failed scheduled entities:
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled History
List.

Result:

The Scheduled History List Query Box is displayed.

............................................................................................................................................................

2 Enter a Scheduled Entity.

............................................................................................................................................................

3 Enter a Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled History List form is displayed with the queried
information.
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Section VI: Provisioning maintenance tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the paper or virtual disconnect tool.

Contents
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Virtual disconnect tool description
....................................................................................................................................................................................................................................

Overview The virtual disconnect tool is used to clean up the Navis™ Optical PM
- NP database when facility, path, or circuit provisioning does not
proceed as planned.

When cross connections are disconnected at the EMS or network
element level without notification to the Navis™ Optical PM - NP
application, the record of the assignment in the application still exists.

The virtual disconnect tool is a means to clean up the Navis™ Optical
PM - NP database without sending commands to the EMS or to the
network elements.

This also might be required, for example, in the unlikely event that an
operator incorrectly assigned a circuit to a wrong black box location
when provisioning the circuit in Navis™ Optical PM - NP. The result
of this script is to cause change to the Navis™ Optical PM - NP
database without interacting with the network elements.

For the task used to perform this function, see the Perform a Virtual
Disconnect task in the Navis™ Optical PM - NP Provisioning Guide.
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6 Reliability and Service Recovery

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains tasks performed to insure the reliability of the
Navis™ Optical PM - NP application. It also contains system recovery
tasks to use if the application becomes unavailable, and a routine
maintenance task.

Contents
Section I: Perform Backups 6-2

Perform a hot backup 6-4

Perform a cold backup 6-5

Section II: Perform Recoveries 6-7

Recovering hot or cold backups 6-8

Perform a hot backup recovery 6-9

Perform a cold backup recovery 6-11

Recover the database to a different server 6-13
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Section I: Perform Backups

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform various types of backups.

Regular backups The system can be set to perform daily backups. The time for the
daily backups is set in the cron file. For information on how to edit
the cron file, see Chapter 3, “System Administration”.

Host database backup Two types of backups are available for HP server systems:

• A hot backup, which occurs when the system is up and running
(hot). A hot backup takes longer to complete than a cold backup;
but a hot backup can be initiated while the application is running.

• A cold backup, which occurs when the Navis™ Optical PM - NP
application is shut down (cold). The application must be stopped
before a cold backup can be initialized.

Hot backup The system automatically backs up the database on Sunday, Tuesday,
Wednesday, Thursday, and Friday at 2:00 a.m. if a tape is loaded in
the tape drive. A customer can alter the run frequency of hot backups
by changing the run time in the cron file.

The system is required to be at run level 4 for a hot backup. See “run
level 4” (2-5) for more information on this run level.

Operator action is not required during the hot backup, which takes
from 60 to 180 minutes to complete, depending on the database size.
The default database backup retention is 5 days (5 tapes/rotation).

Cold backup A cold backup is the most accurate type of backup.

Operator action is required during the cold backup procedure. The
system must be set at run level 3 for cold backup. See “run level 3”
(2-5) for more information on this run level.

The system must be down to run cold backups. We recommend that
cold backups be run every week; however. it is up to the customer to
determine run frequency.

Reliability and Service Recovery
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Perform a hot backup
....................................................................................................................................................................................................................................

Purpose This procedure is used to run a hot backup manually at a time other
than when it is scheduled to run in a cron job.

A hot backup occurs daily as the result of an entry in the cron job.
This backup occurs when the system is up and running.

Task Use these steps to do a hot backup:
............................................................................................................................................................

1 Using the system console, log in to the system as root.

............................................................................................................................................................

2 Remove the daily backup tape and insert the hot backup tape into the
tape drive.

Important! Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

3 Enter /bin/ksh /usr/dacscan/bin/hot_backup

Result:

The hot backup begins, and will take 60 to 180 minutes to
complete. The # prompt appears on the system console when the
backup is completed.

............................................................................................................................................................

4 Remove the hot backup tape.

............................................................................................................................................................

5 Label the tape hot backup and add the:

• current date

• host server name

............................................................................................................................................................

6 Store the tape in a safe place.

Result:

The hot backup is complete.

............................................................................................................................................................

7 Insert the daily backup tape into the tape drive.
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Perform a cold backup
....................................................................................................................................................................................................................................

Purpose A cold backup occurs when the Navis™ Optical PM - NP application
is shutdown (cold). This task should be completed once a month.

Task Use these steps to do a cold backup:
............................................................................................................................................................

1 Using the system console, log in to the system as root.

............................................................................................................................................................

2 At the prompt, type init 3 to stop the Navis™ Optical PM - NP
application.

............................................................................................................................................................

3 Log in to the HP server as root.

............................................................................................................................................................

4 Remove the daily backup tape and insert the cold backup tape into
the tape drive.

............................................................................................................................................................

5 Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

6 Enter /bin/ksh /usr/dacscan/bin/cold_backup

Result:

The cold backup begins, which takes approximately 40 minutes
to complete. The # prompt appears on the system console once
the backup is completed.

............................................................................................................................................................

7 Remove the cold backup tape.

............................................................................................................................................................

8 Label the tape cold backup and add the:

• current date

• host server name

............................................................................................................................................................

9 Store the tape in a safe place.
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............................................................................................................................................................

10 Insert the daily backup tape into the tape drive.

Result:

The backup is completed.

............................................................................................................................................................

11 At the prompt, enter shutdown -ry 0 to reboot the host server to
clean up UNIX system files.

Result:

The host server shuts down and restarts, which takes
approximately 10 minutes to complete. The prompt reappears
once the process is completed.

............................................................................................................................................................

12 Log in to the system as root.

............................................................................................................................................................

13 At the prompt, enter init 4 to start the Navis™ Optical PM - NP
application.

Result:

The application is started.

............................................................................................................................................................

14 Optionally enter top to display the status of the start process. Press
the Ctrl and C keys to exit the display.
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Section II: Perform Recoveries

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform various types of recoveries.

Contents
Recovering hot or cold backups 6-8
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Recovering hot or cold backups
....................................................................................................................................................................................................................................

Introduction Two types of recovery are available:

• recovering a hot backup

• recovering a cold backup

Recovering a Hot Backup Hot backups are recovered using the hot_recover script. The Navis™

Optical PM - NP application must be shut down to perform this
procedure.

Recovering a Cold Backup Cold backups are recovered using the cold_recover script. The Navis™

Optical PM - NP application must be shut down to perform this
procedure.

Recovering the database
to a different server

The database can be recovered on a different server after a hot backup
is completed.

Assumptions

• Both systems have network connectivity to all workstations,
external servers, and network elements. This connectivity
establishes a disaster recovery site.

• The systems have been installed with an identical release of the
Navis™ Optical PM - NP application software, including identical
environment variable settings.

• The systems have both been licensed for identical features and
network elements.

• The system administrators at both sites are synchronizing the
following files:

- /etc/passwd

- /etc/hosts

- /usr/dacscan/oam/config_data/cm/ccpm/ccpconfig (all
references to hostnames except those that contain the local
hostname)

- user’s accounts use the HP-UX system administration tool,
SAM
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Perform a hot backup recovery
....................................................................................................................................................................................................................................

Purpose This procedure is used to perform a hot backup recovery.

Before You Begin Be sure that you have the hot backup tape containing the:

• current date

• host server name

Task Use these steps to perform a hot backup recovery:
............................................................................................................................................................

1 Using the system console, log in to the system as root.

............................................................................................................................................................

2 At the prompt, type init 3 to stop the Navis™ Optical PM - NP
application.

............................................................................................................................................................

3 Insert the hot backup tape into the tape drive.

............................................................................................................................................................

4 Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

5 At the prompt, enter su - dacscan

............................................................................................................................................................

6 At the prompt, enter /bin/ksh /usr/dacscan/bin/hot_recover

Result:

The hot backup recovery begins. It takes approximately 90
minutes to complete. The # prompt appears on the system
console once the hot backup recovery is complete.

............................................................................................................................................................

7 Remove the tape.

............................................................................................................................................................

8 Label the tape with the current date, and store the tape in a safe place.

Result:

The hot backup recovery is completed.
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............................................................................................................................................................

9 At the prompt, enter init 4 to start the Navis™ Optical PM - NP
application.

Result:

The application is started.
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Perform a cold backup recovery
....................................................................................................................................................................................................................................

Purpose This procedure is used to perform a cold backup recovery.

Before You Begin Be sure that you have the cold backup tape containing the:

• current date

• host server name

Task Use these steps to perform cold backup recovery:
............................................................................................................................................................

1 Using the system console, log in to the system as root.

............................................................................................................................................................

2 At the prompt, type init 3 to stop the Navis™ Optical PM - NP
application.

............................................................................................................................................................

3 Insert a tape with a valid cold backup into the tape drive.

............................................................................................................................................................

4 Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

5 At the prompt, enter su - dacscan

............................................................................................................................................................

6 Enter /bin/ksh /usr/dacscan/bin/cold_recover

Result:

A prompt appears and asks for the date of the backup tape.

............................................................................................................................................................

7 Enter YYYYMMDD (or YYMMDD for older tapes).

Important! The date entered must match the date on the backup
tape.

Result:

The cold backup recovery begins, which takes approximately 90
minutes to complete. The # prompt appears on the system
console when the backup is completed.

Section II: Perform Recoveries Reliability and Service Recovery
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............................................................................................................................................................

8 Remove the tape.

............................................................................................................................................................

9 Label the tape with the current date, and store the tape in a safe place.

Result:

The cold backup recovery is completed.

............................................................................................................................................................

10 At the prompt, enter init 4 to start the Navis™ Optical PM - NP
application.

Result:

The application is started.

Section II: Perform Recoveries
Perform a cold backup recovery
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Recover the database to a different server
....................................................................................................................................................................................................................................

Purpose This procedure is used to recover the database to a different server.
This procedure can be used for system upgrades or when it is
necessary to analyze data when trouble clearing.

Before You Begin The task can only be performed after a hot backup has been
completed.

• Create a hot backup tape at the site which has the source
database, using the task “Perform a hot backup” (6-4).

• Ensure that the destination system is at run level 3.

• Recover the hot backup tape at the destination site, using the task
“Perform a hot backup recovery” (6-9).

• On each workstation:

- Ensure that the hostnames/IP addresses for both Navis™

Optical PM - NP systems (source and destination) are in
/etc/hosts.

- Ensure that the hostnames for both Navis™ Optical PM - NP
systems (source and destination) are present in /.rhosts.

- Ensure that the hostnames for both Navis™ Optical PM - NP
systems (source and destination) are present in
/home/dacscan/.rhosts.

Task Use these steps to recover the database to a different server:
............................................................................................................................................................

1 Using the system console, log in as dacscan on the Navis™ Optical
PM - NP server.

............................................................................................................................................................

2 Enter ksh /usr/dacscan/bin/local.sh.

Result:

This script resets the active controller field in the database with
the name of the new hostname.

Section II: Perform Recoveries Reliability and Service Recovery
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............................................................................................................................................................

3 For any network elements that require knowledge of the connecting
manager, refer to their documentation for procedures to enable
connections.

............................................................................................................................................................

4 For each user on each desktop, reset the name of the Navis™ Optical
PM - NP application to which the user should connect.

............................................................................................................................................................

5 Enter the command init 4 to bring the system to run level 4.

Result:

The Navis™ Optical PM - NP application is started.

Section II: Perform Recoveries
Recover the database to a different server
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Section III: Delete History

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the delete history tool, which is an off-line tool
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About this tool
....................................................................................................................................................................................................................................

Background Whenever a circuit is rearranged, the data from the previous circuit is
retained in the Navis™ Optical PM - NP database. A circuit that has
been rearranged several times accumulates substantial history
information. The Delete History script, which is an off-line tool,
retains only the necessary history data associated with each circuit,
and deletes all unnecessary history data from the database.

The Delete History script consists of two parts:

• A script that automatically runs once when upgrading the
database to a new version. If you need to refer to any circuits
listed in the history that are not the most recent non-RS
(restoration), non-RI (reinstatement) circuits, print out these
circuits before upgrading the database. The Delete History script
deletes these circuits from the history during the upgrade.

• A daily script execution that runs immediately following each
successful daily backup.

Section III: Delete History Reliability and Service Recovery
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7 Off-Line Tool Concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes off-line script tools provided with Navis™

Optical PM - NP. It also contains tasks associated with off-line tools.

Contents
Section I: INSERTNODE and REMOVENODE
Tools

7-2

Insert a Navis™ Optical EMS-controlled node into a
digital link using INSERTNODE

7-4

Delete a Navis™ Optical EMS-controlled node from
a digital link using REMOVENODE

7-8

Section II: Bulk Circuit Provisioning Tool 7-10

Bulk circuit provisioning tool task 7-11

Section III: User Transaction Log 7-13

User Transaction Log 7-14

Section IV: Delete History Order 7-16

Delete History Order Tool 7-17
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Section I: INSERTNODE and REMOVENODE Tools

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on the INSERTNODE and
REMOVENODE tools, which are UNIX scripts that allow users to
insert and remove network elements from the Navis™ Optical PM -
NP application. These tools automatically update the Navis™ Optical
PM - NP database.

The INSERTNODE tool uses cross-connect and port files when
inserting a node; files are not needed when removing a node.

Features The INSERTNODE and REMOVENODE tools provide the following
features:

• The Navis™ Optical PM - NP configuration is updated locally;
commands are not sent to the EMS.

• Digital links can be part of a path-switched ring or a
line-switched ring.

• The MSP digital link and Optical Multiplex Section (OMS) with
OMS Protection (OMSP) are supported.

• Updates of one-way, two-way, and broadcast paths/circuits are
handled.

• Handles fault management reconciliation in case trails or ports
involved in the procedure are alarmed.

• Combo circuits are handled the same as VTn/STSn paths.

• Path trace parameters, PTI, and PT mismatch detection mode are
handled.

• Removing a black box from a physical link is supported.

• Inserting a node into a digital link is supported and digital links
from EC-1 and OC-192 to are supported.

• Inserting a node into an OMS and an optical link is supported.

• Removing a node from two digital links is supported and digital
links from EC-1 to OC-192 are supported.

Off-Line Tool Concepts
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• Removing a node from 2 OMS and 2 Optical Layer (OL) is
supported.

• Removing a black box is supported.

Using the tool The tasks that utilize these tools are located after this description.

Supported network
elements

For the Navis™ Optical PM - NP and Navis™ Optical EMS
applications, the INSERTNODE and REMOVENODE tools support
the network elements that are listed in the Navis™ Optical PM - NP
Provisioning Guide and the Navis™ Optical EMS Applications and
Planning Guide.

Supported physical link
types

The INSERTNODE tool supports the following physical type links:

• Optical Multiplex Section

• Optical Link

The REMOVENODE tool supports the following physical type links:

• Optical Multiplex Section

• Optical Layer

Contents
Insert a Navis™ Optical EMS-controlled node into a
digital link using INSERTNODE

7-4

Delete a Navis™ Optical EMS-controlled node from
a digital link using REMOVENODE

7-8

Section I: INSERTNODE and
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Overview
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Insert a Navis™ Optical EMS-controlled node into a digital link
using INSERTNODE
....................................................................................................................................................................................................................................

Purpose This procedure is used to insert a Navis™ Optical EMS-controlled
network element into a digital link using the INSERTNODE tool.
Upon completion, the task generates a cross connect and port file to
update the Navis™ Optical PM - NP database.

Before you begin We recommend that you contact Lucent Customer Support before you
begin to use this tool.

Before you insert an Navis™ Optical EMS controlled network element
into a digital link, consider the following:

• The network element to be inserted in the database of the Navis™

Optical PM - NP must be correctly installed on the network and
must be already known by Navis™ Optical PM - NP; that is, it
must appear on the Navis™ Optical PM - NP Network Map,
which occurs when all ports are provisioned and all cross
connections are made on the EMS being managed by the Navis™

Optical PM - NP application.

• When inserting a node, the network element must be
pre-provisioned; all ports must be provisioned and
cross-connected as needed to provide services.

• This procedure can be done before or after the fibers are
physically reconnected to insert or remove a node.

• Successfully using INSERTNODE before reconnecting the fibers
ensures that the reconnection of the fiber minimizes the risk of
interrupting any logical paths carried by the physical layer.

• The EMS provides a file with port provisioning and
cross-connect status. This file should be created just before the
tool is executed. The user must transfer this file to the Navis™

Optical PM - NP host and specify the full path at the beginning
of the procedure.

• If the EMS reports more cross connections than are needed, an
error has not occurred. These cross connections are displayed in
the Uncorrelated Cross Connect forms after the user does a
DBSync.

Section I: INSERTNODE and
REMOVENODE Tools
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• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.

• The physical link where the node is inserted or removed should
be in the in-effect state. Scheduled paths should not be riding on
the digital link to be updated.

• Preplan paths should not be associated with any of the paths
carried by the physical link to be updated.

• Performance Monitoring (PM) data collection on the physical
links should be stopped prior to execution of this task. When
inserting a node, PM data collection should be stopped on the
STS-3c substructured paths, terminating on the inserted node. PM
on the path going through the inserted node does not have to be
stopped.

• The regenerators or amplifiers with OMS must be removed from
the digital links before running this tool. After the task is
completed, the user will put back the regenerators/amplifiers on
the new physical links.

• The Navis™ Optical PM - NP user interface may not reflect the
correct configuration at the run time of the tool. While the tool is
in progress, the user should refrain from modifying/deleting
existing paths that ride on the digital link where the tool is being
executed. We recommend that the user interface should be down
when the tool is run. If the user interface is not down, the user
has to Refresh the Network Map and any forms that are open.

• A time slot or frequency interchange in the cross connects is not
on the inserted/removed node. The EMS does not report cross
connections with timeslot or frequency interchange. The EMS
also does not report SNCP cross connects in the inserted/removed
node.

Task Use these steps to insert a Navis™ Optical EMS-controlled node
into a digital link using the INSERTNODE tool:
............................................................................................................................................................

1 Log in to Navis™ Optical EMS as ems.

............................................................................................................................................................

2 At the prompt, enter

cd /ems/bin

<node_path>

Section I: INSERTNODE and
REMOVENODE Tools
Insert a Navis™ Optical EMS-controlled
node into a digital link using
INSERTNODE

Off-Line Tool Concepts

....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002

Lucent Technologies 7 - 5



Result:

<node_path> is executed and the following two files are
generated:

/tmp/db_snms_xc_ddmmyyyy_hhmm
/tmp/db_snms_pp_ddmmyyyy_hhmm

............................................................................................................................................................

3 Use ftp or rcp to get these two files to the Navis™ Optical PM - NP
host /usr/dacscan/data then record the path name on the Navis™

Optical PM - NP host.

............................................................................................................................................................

4 Log in to the Navis™ Optical PM - NP host machine as root and
enter the password.

............................................................................................................................................................

5 At the prompt, enter cd /usr/dacscan/data

............................................................................................................................................................

6 At the prompt, enter

chmod 777 db_snms_xc_ddmmyyyy hhmm

chmod 777 db_snms_pp_ddmmyyyy hhmm

............................................................................................................................................................

7 At the prompt, enter su - dacscan.

Result:

The user is changed to dacscan.

............................................................................................................................................................

8 At the prompt, enter cd /usr/dacscan/bin.

Result:

The prompt appears in the requested directory.

............................................................................................................................................................

9 At the prompt, enter INSERTNODE.

Result:

The INSERTNODE tool is initiated.

Section I: INSERTNODE and
REMOVENODE Tools
Insert a Navis™ Optical EMS-controlled
node into a digital link using
INSERTNODE
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............................................................................................................................................................

10 At the CLO/Order Number prompt, enter the value of the digital link
where the new node will be inserted.

............................................................................................................................................................

11 At the Network Element Name prompt, enter the name of the network
element that will be inserted.

............................................................................................................................................................

12 At the PORT ADDRESS to original A prompt, enter the service port
address (in PM-NP Port Address-format) that will connect to the
original digital link’s A location.

............................................................................................................................................................

13 At the PORT ADDRESS to original Z prompt, enter the service port
address (in PM-NP Port Address-format) that will connect to the
original digital link’s Z location.

............................................................................................................................................................

14 At the Digital Link 1 CKT ID prompt, enter the circuit ID for the
first new digital link.

Result:

This link’s terminations are the original digital link’s A location
on the <new_node_name>.

............................................................................................................................................................

15 At the Digital Link 2 CKT ID prompt, enter the circuit ID for the
second new digital link.

Result:

This link’s terminations are the original digital link’s Z location
on the <new_node_name>.

............................................................................................................................................................

16 At the EMS Port Provision File prompt, enter the full path name
of the EMS port provisioning file.

............................................................................................................................................................

17 At the EMS Cross Connect File prompt, enter the full path name of
the EMS cross connect file.

............................................................................................................................................................

18 At the Is this all correct prompt, enter Y or N.

Section I: INSERTNODE and
REMOVENODE Tools
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node into a digital link using
INSERTNODE

Off-Line Tool Concepts

....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002

Lucent Technologies 7 - 7

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Delete a Navis™ Optical EMS-controlled node from a digital
link using REMOVENODE
....................................................................................................................................................................................................................................

Purpose This procedure is used to remove a Navis™ Optical EMS-controlled
network element from a digital link using the REMOVENODE tool.

Before you begin We recommend that you contact Lucent Customer Support before you
begin to use this tool.

Before you remove a Navis™ Optical EMS network element from a
digital link, consider the following:

• This task can be used before or after the fibers are physically
reconnected to insert or remove a node.

• Successfully using REMOVENODE before reconnecting the
fibers ensures that the reconnection of the fiber minimizes the
risk of interrupting any logical paths carried by the physical
layer.

• The EMS provides a file with port provisioning and cross
connect status. This file should be created just before the tool is
executed. A user will transfer this file to the Navis™ Optical PM
- NP host and will specify the full path at the beginning of the
task.

• The EMS might report more cross connections than are needed,
which is not an error. These cross connections will be displayed
in the Uncorrelated cross connect forms after the user does a
database synchronization.

• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.

• The physical link where the node is inserted or removed should
be in the in-effect state. There should not be any scheduled paths
riding on the digital link to be updated.

• Preplan paths should not be associated with any of the paths
carried by the physical link to be updated.

• The regenerators or amplifiers with OMS must be removed from
the digital links before running this tool. After the task is
completed, the user will put back the regenerators/amplifiers on
the new physical links.

Section I: INSERTNODE and
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• The Navis™ Optical PM - NP user interface may not reflect the
correct configuration at the run time of the tool. While the tool is
in progress, the user should refrain from modifying/deleting
existing paths that ride on the digital link where the tool is being
executed. We recommend that the user interface should be down
when the tool is run. If the user interface is not down, the user
has to Refresh the Network Map and any forms that are open.

• A time slot or frequency interchange in the cross connects is not
on the inserted/removed node. The EMS does not report cross
connections with timeslot or frequency interchange. The EMS
also does not report SNCP cross connects in the inserted/removed
node.

Task Use these steps to remove an Navis™ Optical EMS-controlled
node from a digital link:
............................................................................................................................................................

1 Log in to the Navis™ Optical PM - NP server as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd /usr/dacscan/bin then enter REMOVENODE.

Result:

The tool is initiated and a prompt appears.

............................................................................................................................................................

3 At the Network Element name prompt, enter the name of the
network element that will be removed.

............................................................................................................................................................

4 At the first CLO/Order Number prompt, enter the value of the first
digital link from where the node will be removed.

............................................................................................................................................................

5 At the second CLO/Order Number prompt, enter the value of the
second digital link from where the node will be removed.

............................................................................................................................................................

6 Enter the CKT ID (All Fields of the Format) for the new digital link.

............................................................................................................................................................

7 At the Is this all correct prompt, enter Y or N.

Section I: INSERTNODE and
REMOVENODE Tools
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Section II: Bulk Circuit Provisioning Tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the bulk circuit provisioning tool.
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Bulk circuit provisioning tool task
....................................................................................................................................................................................................................................

Purpose This procedure is used to use the bulk circuit provisioning tool.

Before you begin We recommend that you contact Lucent Customer Support before you
begin to use this tool.

Be sure to create a VT1.5 from the Network Map.

Contact Lucent Customer Support if you need assistance with using
this tool.

Task Use these steps to run the bulk circuit provisioning tool:
............................................................................................................................................................

1 Using the Network Map, create a VT1.5 and optionally create a T1 on
the VT1.5. Refer to the Navis™ Optical PM - NP Provisioning Guide.

............................................................................................................................................................

2 Log in to the server as dacscan then enter cd /usr/dacscan/
toolbin.

............................................................................................................................................................

3 In the /usr/dacscan/toolbin directory, create a data_file file.

............................................................................................................................................................

4 Add the following information to data_file, then save and close the
file.

• Circuit ID <CKT_ID> of the created VT1.5 circuit.

• Total number of VT1.5 circuits to be created during the bulk
provisioning.

• External port address of the VT1.5 at the A_location

• External port address of the VT1.5 at the Z_location

• A to Z Path Trace ID (transmitting).

• Z to A Path Trace ID (receiving).

• Y(es) or N(o) value to specify if a T1 should be created over the
VT1.5.

• Y(es) or N(o) value to specify if alarms should be ignored during
the bulk provisioning.

Section II: Bulk Circuit Provisioning Tool Off-Line Tool Concepts
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............................................................................................................................................................

5 In the /usr/dacscan/toolbin directory, create and save an index file
that contains the directory path of the data_file. For example:
/usr/dacscan/toolbin/data_file.

............................................................................................................................................................

6 At the prompt, enter /usr/dacscan/toolbin/group_prov
<indexfilename> -p

Result:

A prompt appears requesting a proxy host.

If you are not prompted to enter the proxy host, none of the
VT1.5s will be added and an error message appears indicating
that there are other proxyproc processes on the system.

............................................................................................................................................................

7 At the prompt, enter the proxy host.

Result:

The script continues to run.

Section II: Bulk Circuit Provisioning Tool
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Section III: User Transaction Log

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the User Transaction Log.
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User Transaction Log
....................................................................................................................................................................................................................................

Purpose This procedure is used to access the User Transaction Log.

Related Information The User Transaction Log provides friendly and practical access to
user transaction attempts or sessions. The User Transaction Log
includes basic information—presented in easy terms—such as the user
ID, time, screen, and operation.

The User Transaction Log records the transaction requests from the
desktop and the Navis™ Optical PM - NP acceptance of the request.
The Log does not track the downstream end result of a network
element or an EMS transaction. For any given user transaction
attempt, only one Transaction Record is logged. The successful
beginning of a transaction is logged or the failed attempt is logged in
order to gather the user’s intentions for the transactions that were not
successful. Transactions over the Northbound interface are not logged.

All user sessions are logged with the following fields for each
attempted transaction:

• user ID

• the desktop name used for the session (client name)

• the date and time of the transaction in time/date format:
24HH:MI:SS in the Navis™ Optical PM - NP time zone

• the attempted transaction in the form of:
Transaction Name: Screen/Operation: Transaction Outcome:
Fields

The User Transaction Log supports on-line storage and retrieval
capabilities for the most recent 31 days, which is subject to the disk
space allocated during installation. When the logs are accessed, output
files are created for viewing or printing—the placement of these
output files is the customer’s option and the housekeeping of these
output files is the customer’s responsibility.

The compressed Transaction Log storage is limited to a maximum of
44Mb or 220k Transaction Records. Beyond this limit, a portion of
the oldest records are deleted automatically and the logging continues
without user notification.

Section III: User Transaction Log Off-Line Tool Concepts
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Before you begin The User Transaction Log is only accessible to users who have
dascan privileges.

The format of the display_userlog command is:

display_userlog user=<username> start_date=”<dd/mm/year>”
end_date=”<dd/mm/year> time”

Example: display_userlog user=jll start_date=”18/09/2000”
end_date=”29/02/2000 12:12”

Task Use this step to access the User Transaction Log:
............................................................................................................................................................

1 Log on to the HP server that is running the Navis™ Optical PM - NP
application.

............................................................................................................................................................

2 Input the following command line: display_userlog.

Result:

The system outputs the User Transaction Log.

............................................................................................................................................................

3 To exit the User Transaction Log, enter: q.

Section III: User Transaction Log
User Transaction Log
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Section IV: Delete History Order

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the Delete History Order off-line tool.
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Delete History Order Tool
....................................................................................................................................................................................................................................

Features The Delete History Order off-line tool is a script that is run
automatically to rid the database of any redundant History Order
(Type HI) that appears for a given CAC number and associated
record. Only the HI order with the most-recent in-service date is
identified and retained.

The Delete History Order off-line tool runs as a cron job and as a
database upgrade tool.

Note: Once the Navis™ Optical PM - NP application is installed, no
practical need exists for on-going system administrator access to the
Delete History Order tool. The upgrade script and the setting of the
cron job are done during installation, so the Delete-HI script is
executed automatically every 24 hours as part of hot_backup. If the
backup tape is not in place, daily backup is not run and the HI orders
accumulate until the next daily backup.

The Delete History Order is only accessible to users who have system
administrator privileges.
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8 EMS Management

Overview
....................................................................................................................................................................................................................................

Purpose This chapter explains the tasks needed to interact with subsystems in
the network.

Contents
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Section I: Interaction with the Navis™ Optical EMS

Overview
....................................................................................................................................................................................................................................

Purpose This section explains how to administer the Navis™ Optical EMS,
which is management system for the Navis™ product family, providing
Element Management Layer (EML) management functions for the
Navis™ optical products. This system has configuration management,
fault management, performance management, and security
management functions.
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Synchronize the Navis™ Optical PM - NP database
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8-11
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Add a new Navis™ Optical EMS
....................................................................................................................................................................................................................................

Purpose This procedure relies on an off-line tool to add a new Navis™ Optical
EMS to the Navis™ Optical PM - NP application or to establish a
cut-through to Navis™ Optical EMS.

Important! This task must be run for each Navis™ Optical EMS
to be added.

Before you begin Collect the following information for the particular Navis™ Optical
EMS system:

• system name

• IP address

Task Use these steps to add a new Navis™ Optical EMS:
............................................................................................................................................................

1 Log in as root to the Navis™ Optical PM - NP host.

............................................................................................................................................................

2 At the prompt, enter ksh /usr/dacscan/bin/add.controller and
press Enter.

Result:

The following prompt is displayed along with a menu of all
possible controllers:

Which Controller do you want to add to this WS-NMS?

............................................................................................................................................................

3 At the prompt, enter 17, which is External SNMS (SDH add/drop
multiplexers)and press Enter.

Result:

The following prompt is displayed :

What is the name of the SNMS?

............................................................................................................................................................

4 Enter the name of the Navis™ Optical EMS, then press Enter.

Result:

You are prompted to confirm your entry.
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............................................................................................................................................................

5 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the Navis™ Optical
EMS.

............................................................................................................................................................

6 Enter the IP address for the Navis™ Optical EMS server, then press
Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the Acronym.

............................................................................................................................................................

8 Enter the acronym using all CAPS. Note that this entry is a unique
identifier, which should not be more than four characters long.
Generally, the first four characters of the Navis™ Optical EMS
hostname are used.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

9 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

The original activity screen is displayed.
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............................................................................................................................................................

10 Continue with one of the following steps.

• If you have have additional Navis™ Optical EMSs to add, repeat
Step 4 through Step 9 to continue.

• If you do not have additional Navis™ Optical EMSs to add,
proceed to the next step.

............................................................................................................................................................

11 Enter quit to exit the script.

Result:

The script is exited.

............................................................................................................................................................

12 Using the system console, log in to the new EMS as root.
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Establish a cut-through to the Navis™ Optical EMS
....................................................................................................................................................................................................................................

Purpose This procedure is used to establish a cut-through to the Navis™

Optical EMS.

Before you begin Verify that:

• the Navis™ Optical EMS server is running when this task is
being performed

• the Navis™ Optical EMS server has an entry in its host file for
the Navis™ Optical PM - NP server to allow Orbix to
communicate successfully

It is essential that SAGE is enabled at the Navis™ Optical EMS for
the cut-through to work.

Task Use these steps to establish a cut-through to the Navis™ Optical
EMS:
............................................................................................................................................................

1 Log in as root to the Navis™ Optical PM - NP host.

............................................................................................................................................................

2 At the prompt, enter who -r

Result:

The current run-level is displayed.

............................................................................................................................................................

3 If the run-level value is 3 or less, proceed to the next step.

If the run-level value is greater than 3, type init 3 and proceed to
the next step.

............................................................................................................................................................

4 At the prompt, enter ksh /usr/dacscan/bin/add.controller and
press Enter.

Result:

A list is displayed.

............................................................................................................................................................

5 At the prompt, enter 17, which is External SNMS (SDH add/drop
multiplexers)and press Enter.
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Result:

The following prompt is displayed:

What is the name of the SNMS?

............................................................................................................................................................

6 Enter the name of the Navis™ Optical EMS then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the Navis™ Optical
EMS.

............................................................................................................................................................

8 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

9 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the Acronym.

............................................................................................................................................................

10 Enter the acronym using all CAPS. Note that this entry is a unique
identifier, which should not be more than four characters long.
Generally, the first four characters of the Navis™ Optical EMS
hostname are used.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

11 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.
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Result:

The script is exited.

............................................................................................................................................................

12 At the prompt, enter chown dacscan /var/dacscan/log/data/
orbixd.log*

Result:

The owner of the orbixd.log file is changed.

............................................................................................................................................................

13 At the prompt, enter /usr/dacscan/bin/AddEMS.sh to add any joint
Navis™ Optical EMS/Navis™ Optical PM - NP clients to the Navis™

Optical EMS server.

Result:

A menu is displayed.

............................................................................................................................................................

14 Select option 2 for the Navis™ Optical EMS server.

............................................................................................................................................................

15 At the Enter the SNMS Server Name, then press [return]:?

prompt, enter the hostname of the Navis™ Optical EMS.

............................................................................................................................................................

16 At the Enter the Version of the SNMS <SNMS Name>, then

press [return]: prompt, enter the Navis™ Optical EMS version.

Important! Press Return if this is not applicable.

............................................................................................................................................................

17 At the Are the WS-NMS GUI and SNMS GUI installed on the

same desktop(y/n)? prompt, enter y if a joint workstation is
deployed or n if the Navis™ Optical PM - NP and Navis™ Optical
EMS GUIs are running on separate machines.

............................................................................................................................................................

18 Continue with one of the following options.

• If n was selected in the last step, go to step 20.

• If y was selected in the last step, enter the IP address of the
Navis™ Optical PM - NP and Navis™ Optical EMS GUIs (when
prompted) then go to the next step.
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............................................................................................................................................................

19 Review the displayed prompt, then enter y if the information is
correct.

Result:

The original list is displayed.

............................................................................................................................................................

20 Select quit from the displayed list.

............................................................................................................................................................

21 Use the “Start the Navis™ Optical PM - NP application on a single
server” (3-5) task to start the Navis™ Optical PM - NP application.

............................................................................................................................................................

22 At the prompt, enter who -r.

Result:

The run-level status is displayed.
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Cut-through to an EMS
....................................................................................................................................................................................................................................

Purpose This task is used to cut-through to the Navis™ Optical EMS using the
Navis™ Optical PM - NP.

Task Use the step below to cut-through to the Navis™ Optical EMS.
............................................................................................................................................................

1 On the Network Map or the Network Controller Map, right-click on
an EMS, then select then select Session > Login to EMS.

Result:

A dialog box is displayed, indicating that the request is
processing.
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Synchronize the Navis™ Optical PM - NP database with the
Navis™ Optical EMS database
....................................................................................................................................................................................................................................

Purpose This procedure is used to synchronize the Navis™ Optical PM - NP
database with the Navis™ Optical EMS database.

Task Use these steps to synchronize the Navis™ Optical PM - NP
database with the Navis™ Optical EMS database:
............................................................................................................................................................

1 From the Network Map, select File -> Open Network Controller
Map.

Result:

The Controller Map is displayed.

............................................................................................................................................................

2 On the Network Controller Map, right-click the desired EMS node,
then select Node -> Session -> Start Database Synchronization.

Result:

The Database Download/Synchronization form is displayed and
its EMS ID field is pre-populated with the name of the Navis™

Optical EMS.

............................................................................................................................................................

3 From the Type field’s drop-down menu, select a synchronization type
then press Apply.

..........................................................................................................................................................

4 IF THEN

You select Alarm, an alarm synchronization occurs with
all the network elements under control
of this EMS.

You select Port, a port synchronization is initiated.

You select Switch, a switch synchronization is initiated.

You select All, a full frame synchronization process
occurs, including alarm, equipment,
switch, cross-connect, and protection
group synchronization.
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IF THEN

You select Cross Connect, a cross-connections synchronization
process occurs to update the From
Port, To Port, and type of
cross-connection information in the
Cross-Connection Map database.

You select Protection
Group,

a synchronization occurs to the listed
protection groups.
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Refederate a Navis™ Optical EMS server
....................................................................................................................................................................................................................................

Purpose This procedure is used to refederate a Navis™ Optical EMS server.

When the Navis™ Optical EMS application is upgraded to a new
release, the Navis™ Optical EMS servers must be refederated, which
involves re-establishing the association between the Navis™ Optical
PM - NP and the Navis™ Optical EMS Orbix instances.

Before you begin Be sure that the Navis™ Optical PM - NP server is at run level 4. See
“run level 4” (2-5) for details.

Task Use these steps to refederate Navis™ Optical EMS server(s) from
a Navis™ Optical PM - NP server:
............................................................................................................................................................

1 Using a terminal window on the Navis™ Optical PM - NP server, log
in as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd #/usr/dacscan/toolbin.

............................................................................................................................................................

3 At the prompt, enter . #/refederate_snms <Navis™ Optical
EMS_hostname>.

............................................................................................................................................................

4 Using a terminal window on the Navis™ Optical PM - NP server, log
in as root.

............................................................................................................................................................

5 Determine whether or not the version of the Navis™ Optical EMS has
changed.

• If the version of the Navis™ Optical EMS has not changed, go
to Step 16 .

• If the version of the Navis™ Optical EMS has changed, go to the
next step.

............................................................................................................................................................

6 At the prompt, enter init 3 to bring Navis™ Optical PM - NP to run
level 3.
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............................................................................................................................................................

7 At the prompt, enter /usr/dacscan/bin/AddEMS.sh

............................................................................................................................................................

8 Select option 2 (for Navis™ Optical EMS server).

............................................................................................................................................................

9 At the Enter the SNMS Server Name, then press [return]:?

prompt, enter the hostname of the Navis™ Optical EMS.

............................................................................................................................................................

10 At the Enter the Version of the SNMS <SNMS Name>, then

press [return]: prompt, enter the Navis™ Optical EMS version.

............................................................................................................................................................

11 At the Are the WS-NMS GUI and SNMS GUI installed on the

same desktop(y/n)? prompt, enter y if a joint workstation is
deployed or n if the Navis™ Optical PM - NP and Navis™ Optical
EMS GUIs are running on separate machines.

............................................................................................................................................................

12 If y was selected in the last step, enter the IP address of the Navis™

Optical PM - NP and Navis™ Optical EMS GUIs (when prompted).

............................................................................................................................................................

13 Review the displayed prompt, then enter y if the information is
correct.

............................................................................................................................................................

14 Select quit from the displayed list.

............................................................................................................................................................

15 At the prompt, enter init 4 to bring Navis™ Optical PM - NP to run
level 4.

............................................................................................................................................................

16 At the Navis™ Optical PM - NP GUI client, click the desired Navis™

Optical EMS server icon, then select Session > Start
Communication.

Result:

A dialog box containing the following text is displayed: START

SESSION COMMAND SENT FOR FRAME:<ems_ name>
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............................................................................................................................................................

17 On the dialog box, click OK.

Result:

Communication is re-established between the Navis™ Optical
EMS and Navis™ Optical PM - NP servers. The emsmap.cfg file
is also automatically updated where necessary, therefore, editing
this file is not required.

If communication cannot be immediately established with the
refederated Navis™ Optical EMS server, restart the Navis™ Optical
PM - NP application using the init 3 and/or init 4 commands. See
Start the host application in Chapter 3, “System Administration” for
details.

............................................................................................................................................................

18 For each Navis™ Optical EMS server to be refederated, repeat Step 1
through Step 16 of this task.
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Section II: Database Audit and Synchronization

Overview
....................................................................................................................................................................................................................................

Purpose This section describes alarm database audits and database
synchronization processes and their impact to stored data.
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Alarm database audit 8-17

Database synchronization 8-18
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Alarm database audit
....................................................................................................................................................................................................................................

Overview To optimize certain searches, the Navis™ Optical PM - NP fault
management module has data storage redundancy, which results in an
occasional deviation in data. The Alarm Database Audit feature
corrects this deviation.

A nightly cron job triggers—according to a schedule defined during
installation—an Alarm Database Audit.

The cron job is not triggered if an alarm synchronization with an
EMS is currently in progress. An automatic audit occurs after a
manually triggered alarm synchronization with an EMS.

At the end of an Alarm Database Audit, a message indicates that the
audit is completed. A message is not broadcast if the Alarm Database
Audit does not find any discrepancies.
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Database synchronization
....................................................................................................................................................................................................................................

Overview The Database Synchronization form (described in an earlier chapter)
synchronizes the Controller database and the database of an individual
digital cross-connect system. The synchronization can be partial or
full.

The Controller supports following types of Database Synchronization
processes:

• Alarm Database Synchronization

• Cross Connection Map Database Synchronization

• Equipment Database Synchronization

• Complete Database Synchronization

Facility-based port parameter data synchronization can only be
performed manually (on-demand). The other three types of data
synchronization can be performed either automatically or manually.
The Controller displays associated commands, data and status
messages on the Database Synchronization form.
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9 Trouble Clearing

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes how to turn on trace and view trace files.

For information on fault management and performance monitoring
tasks, refer to the Navis™ Optical PM - NP Maintenance Guide.

Navis™ Optical PM - NP
home directory

The home directory of Navis™ Optical PM - NP is /usr/dacscan. The
application servers reside in the bin directory of the home directory.
Each server has trace information linked to it and it can be turned on
and off via the tinfo file in /usr/dacscan/bin.

Important! The trace files should never be removed while the
application is up under any circumstances.

Definition: trace file A trace file contains information that identifies equipment status at a
given point in time. The typical use of a trace file is to send it to
Lucent technical support to be used as part of their remote
troubleshooting activities.

Contents
Create a host trace file on a server 9-3

Create FM and southbound/northbound trace file 9-5
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View the log files 9-10

View the log file on an HP workstation 9-12

Clear trace files on a server 9-13

Determine which software patch is loaded 9-14

Display the release and load ID 9-15

Create a single file for trace data 9-16

View the console.log file on a Windows PC 9-17
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Create a host trace file on a server
....................................................................................................................................................................................................................................

Purpose This procedure is used to turn on a host trace at a particular server
and to create a host trace file for capturing information.

Before you begin Ensure that the application is at run level 3.

Task Use these steps to create a trace file:
............................................................................................................................................................

1 Enter the command who -r to check the current run level.

Result:

The run level number displays, such as run-level 3.

............................................................................................................................................................

2 If the displayed run level is higher than 3, enter the command init 3
to bring the application up to run level 3.

............................................................................................................................................................

3 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

4 At the prompt, enter cd /usr/dacscan/bin to change to the directory
containing the tinfo file.

............................................................................................................................................................

5 To edit the tinfo file, enter vi tinfo.

............................................................................................................................................................

6 In the tinfo file, locate a line containing the following format:
<servername> -1 0 <servername>. 0 Y.

Important! In your tinfo file, <servername> is replaced with
the actual server name.

............................................................................................................................................................

7 To increase the trace level from 0 (the lowest level) to 5, press the
Esc button, then type :1,$s/-1 0/-1 5/ then press Enter.

Trouble Clearing

....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002

Lucent Technologies 9 - 3



Result:

The lines containing those entries will be substituted with the
higher trace level value, such as <servername> -1 5

<servername>.0 y

............................................................................................................................................................

8 Save and exit the file.

Result:

The file is saved with the new trace level.

............................................................................................................................................................

9 At the prompt, enter init 4 to bring the application up to run level 4.

Result:

Trace is turned on. A trace file is generated and contains a name
in the following format: <servername>.<pid><host_name>.

............................................................................................................................................................

10 Verify that the trace file /dacscan/trace/<servername>.<pid> exists.

Result:

The file appears in the appropriate directory.

............................................................................................................................................................

11 To decrease the trace level from 5 to 0, repeat steps Step 4 to Step 6
to bring up the tinfo file.

Result:

The tinfo file displays.

............................................................................................................................................................

12 Press the Esc button, then type :1,$s/-1 5/-1 0/ then press Enter.

............................................................................................................................................................

13 Write and save the file.

Result:

The file is saved with the new trace level.

To increase the available space in the /dacscan/trace directory, only
retain the latest version of each file, and use rm ulog.<old_date>
command to remove old trace files.

Create a host trace file on a server Trouble Clearing
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Create FM and southbound/northbound trace file
....................................................................................................................................................................................................................................

Purpose This procedure is used to create a fault management (FM) and
southbound/northbound interface trace file on a particular server.

Before you begin Ensure that the application is at run level 3.

Task Use these steps to create a FM and Southbound/northbound trace
file:
............................................................................................................................................................

1 Enter the command who -r to check the current run level.

Result:

The run level number displays, such as run-level 3.

............................................................................................................................................................

2 If the displayed run level is higher than 3, enter the command init 3
to bring the application up to run level 3.

............................................................................................................................................................

3 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

4 At the prompt, enter cd /usr/dacscan and type ls to verify that the
NMSconfig file exists.

..........................................................................................................................................................

5 IF THEN

the NMSconfig file exists, proceed to the next step.
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IF THEN

the NMSconfig file does
not exist,

create the file with the following
information:
EMSTRACE fm_notif -1 -1 0
EMSTRACE fm_gfs -1 -1 -1
EMSTRACE fm_rms -1 -1 -1
EMSTRACE fm_tt 0 -1 0
EMSTRACE fm_server -1 -1 0
EMSTRACE coproc -1 -1 0
EMSTRACE SBGW200LSrv -1 -1 -1
EMSTRACE Cor2tuxSvr -1 -1 -1
EMSTRACE brokerSrv -1 -1 -1
EMSTRACE I2KNL -1 -1 -1
EMSTRACE fm_fls -1 -1 0
EMSTRACE tmf_gateway -1 -1 0
EMSTRACE STMFGWSrv -1 -1 -1
EMSTRACE ExtObserverSrv -1 -1
-1
EMSTRACE ExtAlarmSynchSrv -1 -1
-1
TRACELOGSIZE 5000

............................................................................................................................................................

6 Save and exit the file.

Result:

The file is saved with the new trace level.

............................................................................................................................................................

7 At the prompt, enter init 4 to bring the application up to run level 4.

Result:

Trace is turned on.

............................................................................................................................................................

8 At the prompt, enter cat NMSconfig to verify that the trace file
exists.

Result:

The file displays.

Create FM and southbound/northbound trace
file
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Create a trace file on a desktop
....................................................................................................................................................................................................................................

Purpose This procedure is used to create a trace file for capturing information
on an HP-UX workstation or a PC.

Important! Trace files should never be removed.

Task Use these steps to turn create a trace file on an HP workstation
or on a Windows PC:
............................................................................................................................................................

1 IF THEN

you want to increase global
tracing and turn on
F-interface tracing at an
HP-UX console,

log in to the HP-UX workstation (GUI
machine) as dacscan.

you want to increase global
tracing and turn on
F-interface tracing at a PC
console,

log in to the PC as sa.

..........................................................................................................................................................

2 IF THEN

you want to increase trace
on an HP-UX workstation,

edit the /usr/add-on/ui/jui/bin/run_jnm
file by changing gt=1 to gt=4
fint.tr=4

you want to increase trace
on a PC,

edit the <drive>:\jui\bin\run_jnm.bat
file by changing gt=1 to gt=4
fint.tr=4

..........................................................................................................................................................

3 IF THEN

you want to increase global
tracing and turn on
F-interface tracing at an
HP-UX console,

edit the /usr/add-on/ui/jui/bin/run_jnm
file by gt=1 to gt=4 fint.tr=4

you want to increase global
tracing and turn on
F-interface tracing at a PC
console,

edit the <drive>:\jui\bin\run_jnm.bat
file and enter set trace=5

Trouble Clearing
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............................................................................................................................................................

4 Save the edited run_jnm or run_jnm.bat file.

............................................................................................................................................................

5 Shut down and restart the Navis™ Optical PM - NP application.

For instructions, see “Stop the Navis™ Optical PM - NP application on
the User Interface” (3-13), “Start the Navis™ Optical PM - NP
application on an HP-UX workstation” (3-10), and “Start the Navis™

Optical PM - NP application on a Windows PC” (3-11).

Result:

Tracing is turned on and a trace file is generated.

............................................................................................................................................................

6 Verify that the trace file exists.

Result:

The file appears in the appropriate directory.
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View the core file
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the core file created when a server
dies.

Definition: core file The core file contains information that identifies which process died
and caused the core dump. It is used during troubleshooting to help
identify what caused the server to die.

About the core file When a server shuts down, a core file may be created in
/usr/dacscan/bin. The core file reveals the identity of the server.
Because the server is automatically restarted, service on that particular
function of the system is only impacted for a brief period. Until it has
restarted, information will not be lost because the system’s bulletin
board will buffer services requested upon that server.

Task Use these steps to view the core file:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 At the prompt, type: ls -l core

Result:

The core name displays in the following file format:
core.<PROCESS_NAME>.<process>

............................................................................................................................................................

3 Enter the following command: file core

Result:

A file is created which may be used for verification purposes. It
is stored under the /usr/dacscan/bin directory and is named
core.<PROCESS_NAME>.<process>.
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View the log files
....................................................................................................................................................................................................................................

Overview Operator transaction logs are stored in compressed format in the
/dacscan/log/data directory with the following naming convention:

<log-prefix>.<julian-date>.<hour>.<minute>

The log files are the following:

• The sys (System Event) log file records all system error
messages; the filename is nms.log.<hostname>.

• The dcs (Digital cross connect log) records communication
information with the DACS in the network. The filename is
ne.log.<hostname>.

• The notification log filename is notif.log.<hostname>.

• The Orbix log filename is orbix.log.<hostname>.

• The HP client log filename is console.log; it resides at:
/home/<user_name>/NM/<workstationname> .
<pid>/jui/logs/console.log.

• The PC client log file is stored at <drive>:\jui\logs\<user>.log.

All log files are maintained up to seven days; the oldest file is
overwritten first. One log file is retained for each day of the week.

Log Files All significant events associated with the database backup and transfer
scheme are logged.

The events are also retained in log files in /dacscan/tmp.

Log file management for
joint workstations

Joint workstation logs record all ICA client sessions from a joint
workstation. The log files for the joint workstation are not
automatically deleted by the system. For space consideration, it is
recommended that the system administrator or user manually delete
the log files that are no longer necessary.

Location of log files

Joint workstation log files are located in c:\jui\logs and use the
format <username><win station name>#<a random number>, where:

• <username> is any valid user.

• <win station number> is the console on which the GUI is run.

Trouble Clearing

....................................................................................................................................................................................................................................
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• # is the actual character #.

• <a random number> is any random number assigned (<999).
The random number is attached to the log file to prevent a user
with the same user ID from overwriting a log file that is already
in use.

View the log files Trouble Clearing

....................................................................................................................................................................................................................................
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View the log file on an HP workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the log file residing on an HP
workstation.

Task Use these steps to view the log file:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan

............................................................................................................................................................

2 Change to the directory containing the log file to be viewed. Type cd
/<full_directory_pathname>

For example, type cd /home/<user>/NM/<workstation>.<pid>/
jui/logs/console.log

............................................................................................................................................................

3 Enter pg <logfilename>.log.

Result:

The contents of the log file is displayed.

Trouble Clearing

....................................................................................................................................................................................................................................
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Clear trace files on a server
....................................................................................................................................................................................................................................

Purpose This procedure is used to trace files on a server.

Important! Before you begin this task, be sure that you are in
the correct directory, or a disaster may occur. All deleted files
will not be recovered.

Task Use these steps to clear trace files on a server:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 At the prompt, type:

cd /dacscan/trace

Result:

The directory has changed to the one containing the trace files.

............................................................................................................................................................

3 At the prompt, type:

for i in ’ls’

do

>$i

done

Result:

The trace file’s contents are cleared.

Trouble Clearing

....................................................................................................................................................................................................................................
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Determine which software patch is loaded
....................................................................................................................................................................................................................................

Purpose This procedure is used to determine which software patch is loaded.

Task Use these steps to determine which software patch is loaded:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan

............................................................................................................................................................

2 At the prompt, type swlist | grep PATCH

Result:

A complete patch list is displayed.

Trouble Clearing

....................................................................................................................................................................................................................................
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Display the release and load ID
....................................................................................................................................................................................................................................

Purpose This procedure is used to display the Navis™ Optical NMS release
number and load ID.

Task Use these steps to display the Navis™ Optical NMS release
number and load ID.
............................................................................................................................................................

1 Log in to the server as root or dacscan.

............................................................................................................................................................

2 To display the release number, enter cat /etc/dscan/release.

Result:

The current release number is displayed.

............................................................................................................................................................

3 To display the load ID, enter cat /etc/dscan/ws-nmshr-loadid.

Result:

The current load ID is displayed.

Trouble Clearing

....................................................................................................................................................................................................................................
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Create a single file for trace data
....................................................................................................................................................................................................................................

Purpose This procedure is used to create one file containing information from
one or more trace files created on the server.

Task Use these steps to copy trace source into one file:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan

............................................................................................................................................................

2 At the prompt, type:

cd /dacscan/trace

Result:

The directory has changed to the one containing the trace files.

............................................................................................................................................................

3 At the prompt, type:

tar cvf trace.tar ./*

Result:

The files will be copied into a single file.

Trouble Clearing

....................................................................................................................................................................................................................................
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View the console.log file on a Windows PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the console.log file residing on a PC.

Task Use these steps to view the log file:
............................................................................................................................................................

1 Log in to the PC as sa

............................................................................................................................................................

2 Using Notepad or Wordpad, display the console.log file which
resides in <drive_letter>:\jui\logs\<user>.log

Result:

The file is displayed.

Trouble Clearing

....................................................................................................................................................................................................................................
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10 Patch and Software Upgrade
Tasks

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides Navis™ Optical PM - NP patch and upgrade
information.

Information Information not available.

Contents
Determine which software patch is loaded 10-2

....................................................................................................................................................................................................................................
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Determine which software patch is loaded
....................................................................................................................................................................................................................................

Purpose This procedure is used to determine which software patch is loaded.

Task Use these steps to determine which software patch is loaded:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 At the prompt, type swlist | grep PATCH.

Result:

A complete patch list is displayed.

Patch and Software Upgrade Tasks

....................................................................................................................................................................................................................................
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Appendix A: Navis™ Optical PM - NP
Filesystems

Navis™ Optical PM - NP file systems
....................................................................................................................................................................................................................................

Introduction This appendix contains a list of the Navis™ Optical PM - NP file
systems.

List of file systems The following lists the directory structure supported within the Navis™

Optical PM - NP application.

1. Root directory (/)

2. OS kernel (/stand)

3. Spool directories (/var)

4. Core OS components (/usr)

5. Optional software (/opt)

6. Provisioning documents directory (/dacscan/prov)

7. Alarms directory (/dacscan/alarms)

8. Three Oracle tablespace directories (/oradb, /oradb2, /oradb3)

9. Application logs directory (/dacscan/log)

10. Database redo logs and archives directory (/dacscan/dbarch and
/dacscan/journal)

11. Application users directory (/dacscan/users)

12. Application trace information directory (/dacscan/trace)

13. Temporary directory (/tmp)

14. Application temporary space (/dacscan/tmp)

....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002

Lucent Technologies A - 1



15. Application software (/usr/dacscan)

16. Application software patch history (/patch)

17. Filesystem used for the PAMs feature (/ITM_QA)

Navis™ Optical PM - NP file systems Navis ™ Optical PM - NP Filesystems

....................................................................................................................................................................................................................................
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Appendix B: Navis™ Optical PM - NP
Configuration Parameters

Overview
....................................................................................................................................................................................................................................

Description To change Navis™ Optical PM - NP configuration parameters, contact
Lucent Customer Support.

....................................................................................................................................................................................................................................
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Glossary

A Action
Order Action - Represents the work activities against a facility/circuit order.

Add Channel
One direction of a bidirectional signal; a wavelength being added into the single flow.

Add Side
Hardware that handles a signal coming in from the network to an end terminal.

ADM
Add-drop multiplexer

Aggregate
A collection of one or more network elements and/or aggregates. An aggregate is represented by
a single icon on the Network Map.

AIS
Alarm Indication Signal

AL
Alarm List

Alarm
An event, or a pair of events, that indicates there is a problem that must be resolved by the
operator. Alarms appear in the Alarm List. There are different types of alarms, including current
alarms, repeat alarms, and historic alarms.

Alarmed Object
A network resource on which a problem exists or has existed, and on which a user needs to take
action. The network resource can be a piece of equipment, a port, or a trail.

Archive
The act of copying information to an external device. The file may then be referred to as an
archive file.

....................................................................................................................................................................................................................................
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Area
Networks managed by Navis™ Optical PM - NP can be subdivided into smaller, manageable
networks called areas. An area is a collection of nodes and/or aggregates, and their associated
links. An area is represented by a single icon on the Network Map. Subdividing a network into
areas reduces overcrowding on the display and improves system performance because smaller
amounts of information are exchanged by the subsystems.

Assignable
A characteristic of a trail set at the time of provisioning. In Navis™ Optical PM - NP, a trail
should be set as assignable if it is expected that at least one client trail will be provisioned for
it.

....................................................................................................................................................................................................................................

B BBE
Background Block Errors - An errored block not occurring as part of an SES.

Black box
A functional network unit, displayed on the Network Map, that is not monitored or controlled
by Navis™ Optical PM - NP. An example of a black box is a non-Lucent network element.

BLSR
Bidirectional Line Switched Ring

....................................................................................................................................................................................................................................

C CAC
Circuit access code - A code unique to a particular circuit that equates to a particular Circuit
Identification name for the same facility/circuit. The code is randomly generated in the circuit
provisioning system. The CAC does not change during a facility’s lifetime.

Catalogued connection
A connection that physically or logically exists in the network, and that is recorded in Navis™

Optical PM - NP.

Channel
When either a digital link, path, or facility is channelized, it is subdivided into channels. For
Time Division Multiplexing (TDM) equipment, channels represent the time slots with which
information is carried within a digital link or in a server trail. Channels are created by Navis™

Optical PM - NP for use during circuit/trail provisioning. When creating channels for digital
links, depending on the network element capability, alternate channels are created. The channel
is given an identity when it becomes either a provisioned path or facility, or a subdivision of a
digital link, path, or facility.

Channel Type
Indicates the type of channel riding on a facility/circuit.

....................................................................................................................................................................................................................................
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Circuit
A transmission path through the network, terminating at equipment at both the A and Z ends.
The transmission path combines equipments and channels of facilities. The circuit has a defined
purpose such as data, video, or voice.

Circulate
The act of moving the window at the bottom of a stack (of windows) to the top of the stack.

CKT
Circuit

CLO
Circuit Layout Order - Code (number) identifying a specific circuit layout order (configuration),
and used as the work item tracking key for a circuit order.

COI
Complete Order/Item state - The last state in most circuit order life cycles.

Cold backup
A backup that is performed while Navis™ Optical PM - NP is not running.

Connection
Generic name for all transmission objects managed by Navis™ Optical PM - NP. A connection
can be a trail or a subnetwork connection or a link connection.

Console
A local terminal which is dedicated to administering a single host machine, and connected
directly via a console port.

Controlled network element
A network element controlled by Navis™ Optical PM - NP that displays on the network maps as
nodes interconnected by digital links. These network elements are in constant communication
with their EMS and are controlled by commands sent from the EMS. They also report and show
alarms. See Network element.

CORBA
Common Object Resource Broker Architecture

CTM
Channel Terminations state - The state in a circuit order’s life cycle where the user enters
channel termination information.

Current Alarm
A new alarm received by, or generated by, Navis™ Optical PM - NP.

....................................................................................................................................................................................................................................
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Customer equipment
See Equipment.

....................................................................................................................................................................................................................................

D DA
Digital Cross Connect Alarm - Displays the type of digital cross-connect alarms that are active
on the port. Possible values are: E (equipment alarm), S (signal or loss of signal alarm), P
(performance), M (multiple alarms).

Days Past Due
The number of calendar days (0-30) past the due date of a pending order.

DB
Database

DB Sync
Database Synchronization - Refers to the synchronization of digital cross-connect system
databases with the Navis™ Optical PM - NP database.

DCS
Display Construction Set

DD
Due date - Date when the work requested by the order is to be completed.

Default Weight
Navis™ Optical PM - NP calculated link weight.

Dense Wavelength Division Multiplexing (DWDM)
A connection that combines multiple optical signals to increase capacity. These signals are
amplified as a group and then transported over a single fiber.

Digital link
Fiber or electrical connections between two points. These transport facilities are assignable to
high-order and low-order circuits to carry customer services.

DISC
Disconnect (improper disconnect) - Indicates whether a facility/facility channel has been
improperly disconnected. If it has, a D appears in this field and Navis™ Optical PM - NP lists it
as In-Effect.

Domain
A collection of network elements that can be assigned to specific users in “database
partitioning.”

....................................................................................................................................................................................................................................
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Drop Channel
One direction of a bidirectional signal; a wavelength being dropped from the single flow.

Drop Side
Hardware that handles a signal leaving an end terminal and heading out to the network.

DTE
Data Terminating Equipment

DTS
Digital Transmission System

DWDM
Dense Wavelength Division Multiplexing

DXC
Digital Cross-Connect System - A generic term for electronic cross-connect systems.

DXC Model
The model of the digital cross-connect system frame.

DXCAM
Digital Cross Connect Administration and Maintenance

....................................................................................................................................................................................................................................

E E
Specifies an alarm condition for the equipment assigned to an area.

E1
International facility on which DS0 channels are multiplexed up. The E1 carries 32 channels;
channel 0 is used for signaling between DACS frames. Channel 16 may be used for carrying
DS0 signaling. Otherwise, channel 16 may be used for customer service and signaling is carried
inband.

EBC
Errored Block Count

EML
Element Management Layer

EMS
Element Management System

....................................................................................................................................................................................................................................
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Equipment
Equipment is a network element that will never be controllable. Customer equipment does not
report alarms and the Navis™ Optical PM - NP does not send provisioning commands to
customer equipment. Customer equipment does not appear on the Network Map but does appear
at the Graphical Layout of the provisioned digital link, path, and/or circuit. Although customer
equipment is not displayed on the Network Map, it can be a place holder for end lines. Also
called customer equipment.

ES
Errored Seconds - A one-second period with one or more errored blocks or at least one defect.

Event
Something that has happened — either in the transmission network, or in an EMS that Navis™

Optical PM - NP is managing, or within Navis™ Optical PM - NP itself. Examples of events
include an operation that has succeeded, an operation that has failed, or failure of a network
resource. Failure events give rise to alarms. Some events occur as a pair (a raise followed by a
clear).

External Address
Address used by Navis™ Optical PM - NP in configuration management.

....................................................................................................................................................................................................................................

F Facility
A carrier of low-order trails. A facility is a channel-assignable trail.

Fault State
The state of an alarmed object with respect to its ability to carry traffic.

There are three fault state values:

• “Working” indicates that the object can carry traffic as intended.

• “Degraded” indicates that the object is still carrying traffic but has lost some protection or the
quality of traffic is impaired.

• “Failed” indicates that the object is not carrying traffic.

Faulted connection
A connection that has an event correlated against it.

FM
Fault Management

Form
A task window where the user can enter data, perform commands, and view data from the
system.

....................................................................................................................................................................................................................................
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Full Geographic Redundancy
See Geographic Redundancy

....................................................................................................................................................................................................................................

G Geographic redundancy
Geographic redundancy provides site protection by maintaining a primary server and a standby
server in separate locations and ensuring that the two servers are far enough apart so that
natural disasters or adverse weather conditions cannot affect the primary and standby servers at
the same time. The database of the standby server is maintained as a copy of the primary server.
If the primary server fails, the standby server can be manually brought on-line.

There are two types of geographic redundancy:

• simplified, an optional Navis™ Optical PM - NP feature which uses nightly backups to update the
database of the standby server.

• full, an optional Navis™ Optical PM - NP feature which uses a mirroring facility to update the
database of the standby server every 30 minutes.

The two types of geographic redundancy differ in the frequency of database updates from the
primary server to the standby server.

GR
Geographic Redundancy

GUI
Graphical User Interface

....................................................................................................................................................................................................................................

H Historic alarm
An alarm that has been deleted.

Hot backup
A backup that is performed while Navis™ Optical PM - NP is running.

....................................................................................................................................................................................................................................

I IMP
Implementation state - The state in the life cycle of a circuit order where the digital
cross-connect system commands are implemented.

IMR
Implementation Roll state - The state in the life cycle of a circuit order that permits testing
between the bridge and roll commands.

Int ChType
Internal Channel Type

....................................................................................................................................................................................................................................
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IOR
Inter-operable Object Reference

....................................................................................................................................................................................................................................

L LAY
Layout state

Location
The location code of the equipment or digital cross-connect frame.

LOF
Loss of frame

Log
Record of past and/or current activities.

Logical Port Address (External or Internal)
Address of a channel (logical channel) riding on a higher-order system; the higher-order system
is terminated on a physical port. There are two address formats: network-level (external)
and EMS-level or Network Element level (internal).

LOM
Loss of multiframe

LOP
Loss of pointer

LOS
Loss of signal

LSR
Line-Switched Ring

....................................................................................................................................................................................................................................

M MDI
Miscellaneous Discrete Input

MDO
Miscellaneous Discrete Output

MIB
Management Information Base. A conceptually organized database that contains the management
information accessed through SNMP.

....................................................................................................................................................................................................................................
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MODE
Execution (Restoration) mode of a preplan circuit.

MS
Multiplex Section

MS-SPRING
Multiplex Section-Shared Protection Ring

MSP
Multiplex Section Protection

MT
Moyens de Transmission (Transmission Means)- A digital transmission medium (facility) of
specific bandwidth between A Location and Z Location. Contract circuits are routed on MTs.

....................................................................................................................................................................................................................................

N Navis™ Optical PM - NP System
The Navis™ Optical PM - NP System is a management system for the WaveStar® product
family, providing Element Management Layer (EML) management functions for WaveStar®
products. This system has configuration management, fault management, performance
management, and security management functions.

NE
Network Element

Network
A network carries a payload from one point to another. This payload can consist of data, voice,
video, or images. Only circuits carry data. Digital links, facilities, and paths carry the circuits
that carry the data.

Network connection
A transport connection that is connected at each end to a trail termination point.

Network element
A network element is a functional unit in a customer’s network that the Navis™ Optical PM -
NP displays on the Network Map and is monitored by the Navis™ Optical PM - NP user through
the graphical user interface. Network elements supply switching, transmission, or multiplexing
functionality in a network. A network element is either controlled or noncontrolled.

Node
Physical location representing any managed equipment, including regenerators.

....................................................................................................................................................................................................................................
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Non-assignable
A characteristic of a trail set at the time of provisioning. In Navis™ Optical PM - NP, a trail
should be set as non-assignable if it is expected that no client trail will be provisioned for it.

Non-service-affecting alarm
Alarms categorized as non-service-affecting indicate that at least one channelized facility,
without provisioned circuits, is alarmed.

Noncontrolled network element
A noncontrolled network element is a Black box or Customer equipment that cannot be
controlled by Navis™ Optical PM - NP. These network elements do not report alarms.
Noncontrolled network elements support only manual provisioning and are listed in the database
as a part of provisioning records. See Network element.

NSA
Non-service-affecting

NTN
Network Telephone Number - Used on a network to represent a physical address.

NTN1
Network Telephone Number - Primary telephone number of the digital cross-connect frame on
the packet network.

NTN2
Network Telephone Number - Backup telephone number of the digital cross-connect frame on
the packet network.

....................................................................................................................................................................................................................................

O OA
Optical Amplifier

OCH
Optical Channel

OFS
Out-of-Frame Seconds

OLS
Optical Line System

OMS
Optical Multiplex Section

....................................................................................................................................................................................................................................
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Order
Circuit Order number

OTU
Optical Translator Unit

....................................................................................................................................................................................................................................

P PDH
Plesiochronous Digital Hierarchy

Performance Monitoring (PM) Export
An optional feature that allows performance-monitoring information to be exported to a
predefined data file, which can be used for a variety of purposes.

Physical Port
The object responsible for the processing of the signal on the communication infrastructure. For
an optical port, the physical port is the processing from fiber to the optical MS level.

Physical Port Address (external or internal)
Address of the port that physically terminates a facility.

Plesiochronous Digital Hierarchy
A transmission hierarchy wherein all the elements have the same nominal digital rate but are
synchronized on different clocks (near synchronization).

Port
The port address of the facility.

Post
Command to initiate the continuity check of a facility/circuit layout across the network and to
determine the route of a facility or circuit.

Preplan Circuit
The preplan circuit is the protecting circuit used to restore the service circuit. Also known as
service circuit.

Preplan Restoration
An optional feature that allows a dedicated backup route to be specified for paths and circuits.
When Preplan Restoration is used, a disrupted circuit is temporarily rerouted on an alternate
route to restore service. The restoration process is triggered manually or automatically by an
alarm. Once the alarm situation is resolved, the restored circuit can be manually reinstated to its
original route.

Primary Alarm
An alarm that is a direct result of a failure in the network, such as Loss of Service (LOS).

....................................................................................................................................................................................................................................
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Protection Path
The protection path is a backup route that protects the service path. The service path is the path
that is standards operational.

PSR
Path-Switched Ring

PTI
Path Trace Identifier

....................................................................................................................................................................................................................................

R Receive Date
The date an order is received.

Redline
Indicates whether circuit requires special service protection marking and treatment.

Refederate
The process of re-establishing the association between the Navis™ Optical PM - NP and Navis™

Optical EMS Orbix instances.

Repeat Alarm
A type of current alarm; a current alarm that has the same source as probable cause as another
current alarm becomes a repeat alarm.

Response Display
You specify whether you want to see all responses from the frame, only your own responses, or
your own and alarm responses.

Ring
Rings are formed when the digital links connect all participating network elements to form a
closed loop.

RNAME
The system name that identifies the specific DTE to use to communicate with the packet
network and the host name.

....................................................................................................................................................................................................................................

S SA
Service affecting

Scheduled entity
A provisioning assignment for a facility, path, or circuit that has been designated to occur at a
future date and time. All assignments, with the exception of digital links, can be scheduled.

....................................................................................................................................................................................................................................
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Section
A trail in a section layer.

Service Circuit
See Preplan circuit.

Service Path
The path that is standards operational. The protection path is a backup route that protects the
service path.

Service-affecting alarm
Alarms categorized as service-affectingindicate that at least one non-channelized facility is
alarmed or that at least one channelized facility with provisioned circuits is alarmed.

SES
Severely Errored Seconds - A one-second period that contains 30% or more errored blocks or at
least one defect. SES is a subset of ES.

Shared Risk Group
A group of entities that share the risk among fibers which use the same conduit.

Simplified Geographic Redundancy
See Geographic Redundancy.

SNCP
Subnetwork Connection Protection

SNMP
Simple Network Management Protocol

SNMS
See Navis Optical Element Management System (EMS).

Speed
Baud rate

Status
Current condition or state of progress of an instance or object.

Subnetwork
A collection of interconnected network elements that has a certain behavior. The subnet concept
allows Navis™ Optical PM - NP to manage fixed cross-connect systems and rings through
multiplexers. Also called a ″subnet.″

....................................................................................................................................................................................................................................
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Synchronous Digital Hierarchy
A transmission hierarchy wherein all the elements are synchronized.

Synchronous Optical NETwork (SONET)
An industry standard for high-speed transmission over optical fiber, which specifies a hierarchy
of rates and formats for optical transmission ranging from 51.84 Mbps to 13.271 Gbps. These
rates were created to provide the flexibility needed to transport many digital signals with
different capacities and to provide a design standard for manufacturers.

The SONET protocol stack consists of the following four layers:

• The photonic layer is the electrical and optical interface for the transport of information bits
across the physical medium. It converts STS-N electrical signals to OC-N optical signals. It
performs functions associated with the bit rate, optical-pulse shape, power, and wavelength. It
does not use any overhead.

• The section layer transports the STS-N frame across the optical cable and establishes frame
synchronization and the maintenance signal. Its functions include framing, scrambling, error
monitoring, and orderwire communications.

• The line layer provides the synchronization, multiplexing, and automatic protection switching
(APS) for the path layer. Because it is primarily concerned with the reliable transport of the path
layer payload (voice, data, or video) and overhead, it allows automatic switching to another
circuit if the quality of the primary circuit drops below a specified threshold. Overhead includes
line-error monitoring, maintenance, protection switching, and express orderwire.

• The path layer maps services such as DS3, FDDI, and ATM into the SONET payload format. It
provides end-to-end communications, signal labeling, path maintenance, and control and is
accessible only through terminating equipment. A SONET ADM accesses the path layer overhead;
a cross-connect system that performs section and line layer processing does not require access to
the path layer overhead.

....................................................................................................................................................................................................................................

T Tandem connection
A sublayer between the management system connection and path layer that allows users to
monitor the quality of the signal transport within its managed domain. Tandem connections also
provide users with information about the total quality of a signal before the signal travels from
the user’s managed network to a network managed by a different user. Users can create tandem
connections on paths that do not terminate in its managed network but traverse its network from
other user managed networks.

TCA
Threshold Crossing Alert

TCAL
Traffic Correlated Alarm List

TCM
Tandem Connection Monitoring

....................................................................................................................................................................................................................................
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Termination
Port address

TID
Target Identifier - The target identification name of the digital cross-connect frame, that is used
in the network to identify a digital cross-connect frame. (Same as NEID.)

TMAG
See Transport Manager Application Group.

TP
Termination Point

Trail Termination Point
The transport, trail termination, and adaptation functions that terminate a trail.

TTP
Trail Termination Point

....................................................................................................................................................................................................................................

U UAP
Unavailable Period

UAS
Unavailable Seconds - A period containing 10 or more consecutive Severely Errored Seconds.

UID
User Identification - Host login of the user.

Uncatalogued connection
A connection that physically or logically exists in the network, and that is not recorded in
Navis™ Optical PM - NP.

Uncorrelated Alarm
Specifies an alarm condition that exists on ports or network elements assigned to an area that
does not terminate links, trails, or circuits in Navis™ Optical PM - NP.

Uncorrelated Event
An event that does not affect any trail provisioned in Navis™ Optical PM - NP.

User defined area maps
These maps allow a specific user to define which network elements to display on the screen
within a submap. See User defined submaps.

....................................................................................................................................................................................................................................
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User defined sub maps
These maps allow a specific user to define what areas to display on the screen. See Area and
User defined area maps.

User ID
A login ID. Each user ID represents a person who has been granted access to use Navis™

Optical PM - NP.

User Profile
A user profile is an association of a list of tasks with a User ID. The user profile controls which
tasks the user is allowed to perform.

....................................................................................................................................................................................................................................

V VCIT
Virtual Craft Interface Terminal

Virtual Port
Terminates the two line ports in a protection scheme. You enter the line port addresses in the
normal manner. The virtual port address is in addition.

Virtual Port Address (External or Internal)
Addressing scheme that allows you to enter a virtual port address that controls the two line
ports; the address allows one line port to be the service port and the other line port to be the
protection port. Virtual port addressing is a protection scheme.

VPN
Virtual Private Network

....................................................................................................................................................................................................................................

W Work Log
The history of a work item; a log of significant operations performed on work items.

....................................................................................................................................................................................................................................
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Index

A Add

a regular user, 4-4

a user on a server, 2-52

a user to a SAGE
workstation, 2-55

an area, 5-13

member to aggregate,
5-7

Navis™ Optical EMS,
8-3

user profile, 4-9

Aggregate

add, 5-7

modify acronym, 5-11

Alarm database audit, 8-17

Area

add, 5-13

background information,
5-12

delete, 5-17

modify, 5-15

Area Map, 5-18

add a user defined, 5-19

delete a user defined,
5-21

display/modify a user
defined, 5-20

Asynchronous port for TIM
interface, 2-34

Audience, xiii
........................................................

B Background Map

install, 3-37

Backups, 6-2

cold, 6-2, 6-5

hot, 6-2, 6-4

Black box, 3-41

Buffers

clearing single server,
2-7

Bulk circuit provisioning
tool, 7-11

........................................................

C CDE, 2-38, 2-58, 2-64

Change

model name, 3-43

Clear

log or trace file on a
server, 9-13

single server buffers,
2-7

Cold backup, 6-2, 6-5, 6-11

Command

init, 2-5

lanscan, 2-11

ping, 2-8

shutdown, 2-17

telnet, 2-9

uname, 2-10

vgdisplay, 2-12

who, 2-6

Commands, 2-4

Commenting on user
documents, xvii

Common Desktop
Environment (CDE)
See: CDE

Configuration

parameters, B-1

Conventions

typographical, xvi

Core file, 9-9

Cron file

dacscan, 3-23

edit, 3-25

root, 3-24

Cut-through, 8-3, 8-6, 8-10
........................................................

D Data export feature

administer, 3-28

.....................................................................................................................................................................................................................................
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Database

alarm database audit,
8-17

recover to a different
server, 6-13

recovery, 6-8

synchronization, 8-18

synchronize with an
Navis™ Optical EMS,
8-11

Database cleanup, 5-34

Delete

a user from SAGE
workstation, 2-57

an area, 5-17

Navis™ Optical EMS
controlled node from a
digital link, 7-8

user, 4-8

user profile, 4-13

Delete History Order, 7-16

Delete History tool, 6-15

Desktops, 2-22, 2-23, 2-25,
2-27

Display

release number, 9-15

Documentation

font usage, xvi

how to comment, xvii,
xvii

list of, xvi

on CD-ROM, xvii

on-line version, xvii
........................................................

E Export tool

execute, 3-34

........................................................

F File

dacscan cron, 3-23

root cron, 3-24

File systems, A-1

Filtering criteria

setting, 3-45

Font usage, xvi
........................................................

H Help

screen help, xvii

Host database, 6-8

Hot backup, 6-2, 6-4

Hot backup recovery, 6-9

HP-UX workstation, 2-38

power down, 2-25

power on, 2-22

start the application on,
3-10

stop the application on,
3-13

........................................................

I

Information products

font usage, xvi

how to comment, xvii,
xvii

how to order, xvii

on CD-ROM, xvii

on-line version, xvii

init command, 2-5, 2-7,
3-17

Insert

Navis™ Optical EMS
controlled node into a
digital link, 7-4

INSERTNODE tool, 7-2

Intended audience, xiii
........................................................

L LAN status

view, 2-11

lanscan command, 2-11

load ID, 9-15

Location-type information

network element search,
3-39

Log file

management for joint
workstations, 9-10

view on an HP
workstation, 9-12

view on Windows PC,
9-17

........................................................

M Messages

recovery, 3-26

warning, 3-26

Mirroring status, 2-12

Model name, 3-43

Modify

aggregate acronym, 5-11

an area, 5-15

noncontrollable network
element, 3-41

user ID information, 4-6

user profile, 4-11

Monitoring space, 3-26

.....................................................................................................................................................................................................................................
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........................................................

N Navis™ Optical EMS

add a new, 8-3

interact with, 8-2

Network element

update position on
Network map, 3-38

Node

update position, 3-38
........................................................

O Off-line tools, 7-2

add an EMS, 8-3

Bulk circuit
provisioning, 7-11

Delete History Order,
7-16

Delete History tool,
6-15

exporting PM data, 3-28

install a new
background map, 3-37

User Transaction Log,
7-14

on-line documentation, xvii

On-line help
See: Screen help

Oracle database

restart, 3-19

stop, 3-20

Ordering

information products,
xvii

OS Superuser, 1-3
........................................................

P Parameters, B-1

Patch

software, 10-1

Performance monitoring

displaying variable
settings, 3-30

export tool, 3-34

variables, 3-29

workstation set up task,
3-32

Performance monitoring
data

administer, 3-28

Performance Monitoring
Data Export transfer

schedule run time, 3-31

Power down

HP-UX workstation,
2-25

single server, 2-17

Windows PC, 2-27

Windows terminal
server, 2-19

Power on

HP server
(single-server), 2-14

HP-UX workstation,
2-22

Windows PC, 2-23

Windows terminal
server, 2-15

Preferences

set, 3-46

Printer

add local serial printer,
2-63

add network printer,
2-61

install a network printer
on a Navis™ Optical
PM - NP System, 2-59

set up CDE icon for,
2-64

Privileges

system administrator,
2-50

user, 2-46, 2-48
........................................................

R Recover database to
different server, 6-13

Recoveries

cold backup, 6-11

host database, 6-8

hot backup, 6-9

Refederate Navis™ Optical
EMS server, 8-13

Remove

member from aggregate,
5-9

REMOVENODE tool, 7-2

Restart

Oracle database, 3-19

rhosts file, 3-32

Run level

verify, 2-6

Run levels, 2-5
........................................................

S SAGE, 2-54

SAM

create a user ID, 2-38

create an OS user ID,
2-42

.....................................................................................................................................................................................................................................

365-314-102R1.0
Issue 1, April 2002

Lucent Technologies I N D E X
I N - 3



Schedule

Performance Monitoring
Data Export file
transfer, 3-31

Scheduled entities, 5-26

delete, 5-28

filter list, 5-30

modify, 5-29

view list of, 5-27

view list of
successful/failed, 5-32

Screen help, xvii

Search

network element’s
location type, 3-39

Secure Access Gateway for
Enterprises (SAGE)
Desktop Integration
feature
See: SAGE

Servers

adding a user, 2-52

power down in a single
server configuration,
2-17

power on in a single
server configuration,
2-14

start the application on
a single server
configuration, 3-5

stop the application on
a single server, 3-14

stop the application on
a single server
configuration with a
UPS, 3-17

Set

alarm preferences on
forms, 3-49

event indications
preferences, 3-47

FM operational
preferences, 3-50

map preferences, 3-48

Set up

asynchronous port for
TIM interface, 2-34

CDE printer icon, 2-64

cut-through session for
Navis™ Optical EMS,
8-6

TIM TCP/IP
configuration, 2-31

shutdown command, 2-17

Single server, 3-4, 3-8,
3-12

Software patch, 9-14, 10-2

Space

monitoring, 3-26

Spacewatch program, 3-26

Start

Navis™ Optical PM -
NP server applications,
3-4

Navis™ Optical PM -
NP user interface
applications, 3-8

Start Navis™ Optical PM -
NP

on a single server, 3-5

on a Windows terminal
server, 3-7, 3-9

on an HP-UX
workstation, 3-10

Stop

Navis™ Optical PM -
NP on a single server,
3-14

Navis™ Optical PM -
NP System server
applications, 3-12

Submap

add a user defined, 5-23

delete a user defined,
5-25

display/modify a user
defined, 5-24

user defined, 5-22

Synchronize

Navis™ Optical PM -
NP database, 8-11

System administrator
privileges

assign on a Windows
PC, 2-50

System information, 2-10
........................................................

T telnet command, 2-9, 2-42

TIM interface, 2-34

TIM TCP/IP configuration,
2-31

Tools
See: Off-line Tools

Trace

create on a server, 9-3

create trace files on an
HP-UX, 9-7

fault management, 9-5

southbound/northbound
trace, 9-5

.....................................................................................................................................................................................................................................
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Trace source file

create, 9-16

Typographical conventions,
xvi

........................................................

U uname command, 2-10

Uninterruptible Power
Supply (UPS)

UPS, 3-17

UNIX commands, 2-4

Update

node, 3-38

UPS, 3-17

User

add on a server, 2-52

User defined area map,
5-19

User defined submap, 5-23

User ID

add, 2-38, 2-42

alternate cut-through to
Navis™ Optical EMS,
2-53

creating through SAM’s
GUI-based program,
2-38

User privileges

assigning on a Windows
2000 PC, 2-48

assigning on a Windows
PC, 2-46

User profile, 4-2

add, 4-9

delete, 4-13

modify, 4-11

User Transaction Log, 7-14

User types

system administrator,
1-3

........................................................

V Variables

display performance
monitoring, 3-30

performance monitoring,
3-29

vgdisplay command, 2-12

Virtual disconnect tool,
5-34

........................................................

W who command, 2-6

Windows 2000 PC

assign user privileges
on, 2-48

Windows PC

assign system
administrator
privileges on, 2-50

assign user privileges
on, 2-46

power down, 2-27

power on, 2-23

start the application on,
3-11

stop the application on,
3-13

Windows terminal server

power down, 2-19

power on, 2-15

Windows terminal
serverNavis™ Optical PM
- NP, 3-16

Workstation

add to host, 2-29

SAGE, 2-55, 2-57
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